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Bienvenido a tu curso 
AutoCAD Fundamentos 

 

Al terminar este curso conocerás el uso básico sobre el software asistido por 

computadora (CAD), en el cual se apoyan tanto arquitectos como ingenieros y 

profesionales de la construcción para crear dibujos precisos en 2D. 

 

Preguntas frecuentes sobre nuestros Cursos Presenciales  

 

Preguntas frecuentes sobre nuestros Cursos Online 
 
 
 

Requerimientos mínimos de instalación 

 

Esta guía presenta los requerimientos mínimos que debe contar el equipo para la 
instalación y uso adecuado de la versión más reciente de AutoCAD ® y sus 
respectivas actualizaciones. 
 
Contar con un equipo basado en Windows, con al menos un procesador dual-core 
o superior, con 4 GB o más de memoria RAM, tarjeta gráfica compatible con 
AutoCAD ®1, y con al menos 4 Gb de espacio libre en disco duro. Es recomendable 
equipos basados en Windows con versión de 64 bits y tarjetas gráficas de al menos 
500 MB dedicados. 
 
La guía está enfocada en las bondades que ofrece la versión AutoCAD FULL y en 
las herramientas más relevantes que aplican en el trabajo, así como en temas de 
examen de certificación profesional Autodesk (ACP).  

 
1 https://knowledge.autodesk.com/certified-graphics-hardware 

https://youtu.be/ZsW2LRKwdzE
https://youtu.be/jpGtRSkx8nE
https://knowledge.autodesk.com/certified-graphics-hardware
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Derechos reservados 

© Todos los derechos reservados Darco© 

 
Todos los materiales contenidos en este sitio (incluyendo, pero no limitado a, texto, 
logotipos, contenido, imágenes [animadas y estáticas], iconos videos y fotografías, entre 
otros) están protegidos por las leyes de Derechos de Autor y Propiedad Industrial, tanto 
nacionales como internacionales. 
 
En relación con todo lo contenido en esta guía de estudio, se prohíbe la reproducción, uso, 
copia, impresión, distribución, publicación, traducción, adaptación, reordenación y cualquier 
otro uso o modificación total o parcial de los datos y obras contenidos en esta página, por 
cualquier medio y de cualquier forma. 
 
Para cualquier asunto relacionado con este aviso, por favor contacte a 
darco@darco.com.mx 
 
Aviso de Privacidad 
 
La privacidad de sus datos personales es de gran importancia para Darco por lo que 
hacemos de su conocimiento nuestro Aviso de Privacidad en 
www.darco.com.mx/privacidad 

 
Darco© es una marca registrada 

Autodesk© es una marca registrada￼  
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Capítulo 1 – Conceptos Básicos 
 

Primeros pasos con AutoCAD 

Antes de comenzar a usar el software, es necesario estar familiarizado con la interfaz y 
algunas funcionalidades y características básicas 
 
Objetivo 
 
Al finalizar este capítulo, el alumno estará en capacidad de identificar e indicar el propósito 
de los principales elementos de la interfaz como Abrir, Crear y Guardar Dibujos. 
 

Interfaz del usuario 
 
La interfaz de AutoCAD proporciona acceso rápido a las herramientas más utilizadas para 
aprovechar al máximo el área de dibujo. El valor por defecto de la interfaz incluye: El Menú 
de Navegación, La Barra de Acceso Rápido, InfoCenter, El Ribbon, y La Barra de Estado. 
 
Estas Herramientas son básicas en el desempeño y operación del programa, así como la 
posibilidad de hacer más rápido y eficiente el trabajo en nuestros proyectos. 
 

 
 
• Application Menu  (Menú de Aplicación) 
• Crosshairs and Prompts (Cursor y Ayudas) 
• Drawing Window  (Ventana de Dibujo) 
• Quick Access Toolbar (Barra de Acceso Rápido) 
• Ribbon   (Barra de Herramientas) 
• InfoCenter   (Centro de Información) 
• Command Line  (Línea de Comando) 
• Status Bar   (Barra de Estado) 
• Navigation Bar  (Barra de Navegación) 
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Barra de Herramientas (Ribbon) 
 
La Barra de Herramientas (Ribbon) proporciona una colocación única y reducida de las 
operaciones significativas para el espacio de trabajo actual. Elimina la necesidad de mostrar 
varias barras de herramientas y por consiguiente, reduce la congestión de la ventana de la 
aplicación y amplía el área disponible para trabajar con una interfaz completa. 
 

 
 
El Ribbon se muestra automáticamente cuando se crea o se abre un dibujo. Se puede abrir 
manualmente mediante las siguientes acciones: 
 

• Click en el menú Tools ➤ Palettes ➤ Ribbon. 

• En la línea de comando, escribir Ribbon. 
 
Para cerrar la cinta de opciones (Ribbon), en la solicitud de comando escribir ribbonclose. 
 
El Ribbon se coloca en la parte superior de la ventana de dibujo. Cada pestaña (Menu) 
muestra una etiqueta de texto por defecto (Home, Insert, Annotate, etc). Así como cada 
Pestaña (TAB) viene con sus respectivos Paneles (Ejemplo: TAB HOME → Paneles DRAW, 
MODIFY, BLOCK, LAYERS, etc.). 
 
Dependiendo el espacio de trabajo (Workspace) serán las herramientas que cargue el 
programa en el Ribbon. Para el caso de nuestro trabajo en 2D, seleccionaremos Drafting 
& Annotation. 
 
Localizar el icono de Workspace en la barra de estado, y dar click con el botón derecho del 
mouse para definir nuestro espacio de trabajo en 2D. 
 
Barra de Estado (Status Bar) 
 

 
 
Esta barra se puede personalizar para contar con los elementos que serán de utilidad al 
momento del trabajo sobre el espacio Modelo, y su personalización cuando este en el 
espacio de Layout. 
 
Nota.- En la Pestaña Home encontrará las herramientas necesarias para lograr cualquier 
proyecto. Una pequeña flecha al lado del nombre del panel indica que se puede ampliar 
dicho panel para mostrar herramientas y controles adicionales. Por defecto, un panel 
expandido se cierra automáticamente en cuanto el usuario retira el puntero del panel. Para 
mantener un panel expandido, haga clic en el icono de flecha en la esquina inferior izquierda 
de dicho panel. 
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• Los Tabs, mostrados en amarillo 

• Paneles, mostrados en rojo 

• Icono de comandos y su respectiva ayuda al posicionar el mouse sobre estos, en azul. 
 
Barra de herramientas de acceso rápido 
 
La Barra de herramientas de acceso rápido se encuentra en la esquina superior izquierda 
de la interfaz de AutoCAD, almacena los comandos a los que se accede con más 
frecuencia.  
 
Es una barra de herramientas personalizable que contiene un conjunto de comandos, 
además de que también se encuentra la opción de definir el Espacio de Trabajo. Esta Barra 
es muy semejante en operación y comandos a la que se encuentra en cualquier editor de 
textos de uso común. 
 

 
 
Puede añadir, eliminar y cambiar la posición de los comandos en la Barra de herramientas 
de acceso rápido. Puede añadir tantos comandos como desee. Si no hay espacio 
disponible, los comandos se desplazan a un botón de icono desplegable. Dando clic con el 
botón derecho del mouse y aparecerá el cuadro de ayuda. 
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A continuación, se indican los comandos por defecto de la Barra de herramientas de acceso 
rápido: 
 

 
 

1. Nuevo.- Permite Abrir un Nuevo proyecto. 
2. Abrir.- Permite Abrir proyectos existentes almacenados en nuestras 

carpetas. 
3. Guardar.- Permite asignarle un nombre al proyecto y almacenarlo en 

carpetas. 
4. Guardar Como.- Permite renombrar cualquier proyecto. 
5. Abrir desde la web y un móvil. Abrir proyecto alojado en la nube. 
6. Salvar en la web o un móvil. Salvar directo en la web. 
7. Imprimir.- Permite entrar al Administrador de Impresión. 
8. Deshacer.- Permite regresar a un punto anterior o eliminar los cambios 

recientes hechos en el Proyecto. 
9. Rehacer.- Permite regresar los pasos eliminados recientemente. 
10. Espacio de Trabajo (Workspace).- Permite seleccionar las herramientas 
para trabajar el proyecto. 

 
Barra de estado 
 
La barra de estado de la aplicación muestra los valores de las coordenadas del cursor, las 
herramientas de dibujo, las herramientas de vista rápida, la escala de anotación y la 
Herramienta de Espacio de Trabajo. 
 

 
 
Si vemos el panel de Izquierda a Derecha, lo primero que encuentra son los valores de 
coordenada. Estos valores permiten saber la ubicación exacta del puntero, el orden en el 
que aparecen dichos valores es correspondiente al plano cartesiano, es decir X, Y y Z. 
 

 
 X  Y   Z 
 
Después encontraremos las herramientas de Dibujo, que permite hacer practico y 
productivo el trabajo en nuestros proyectos. Para esta nueva versión 2015 los botones de 
las herramientas de dibujo solo se pueden ver como iconos y no como texto como en 
versiones anteriores. Además, se tendrá la opción de habilitar y deshabilitar la visibilidad de 
las herramientas mediante la pestaña de “Customization”.  
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Nota.- Las Herramientas de dibujo serán indispensables para facilitar y agilizar los trazos 
que utilicemos para la elaboración de nuestro proyecto. 
 
Línea de comandos (Command Line) 
 
Los comandos, las variables de sistema, las opciones, los mensajes y las solicitudes de 
comando se visualizan en esta ventana. La línea inferior de la ventana de comandos se 
conoce como LÍNEA DE COMANDO y muestra la operación que se está llevando a cabo. 
 
Para introducir un comando mediante el teclado, solo hay que escribir el nombre del 
comando o su alias, pulsar la tecla ENTER, barra espaciadora o el botón derecho del mouse 
para que este se active. 
 

 
 
Cuando se introducen comandos en la línea de comando, AutoCAD muestra un conjunto 
de opciones o bien un cuadro de diálogo. Por ejemplo, cuando se escribe CIRCLE en la 
línea de comando, aparece la siguiente solicitud: 
 
Especifique el punto central para círculo o [3P/2P/Ttr (tan, tan, radio)]: 
 

 
 
Puede precisar el centro escribiendo las coordenadas (X, Y) o utilizando el mouse para 
pulsar en cualquier punto de la pantalla.  
 
Para acceder a las operaciones que están dentro de los corchetes, introduzca la letra que 
aparece en mayúscula según sea el caso. Puede introducir tanto letras mayúsculas como 
minúsculas. 
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Por ejemplo. Para seleccionar la opción de tres puntos (3P), escribir 3p. 
 
Nota.- Es muy importante que por ningún motivo mientras se encuentre trabajando con 
AutoCAD pierda de vista la línea de comandos, ya que cualquier instrucción o solicitud del 
programa será por medio de esta ventana. 
 
Menú Contextual (Short Cut Menu) 
 
Permiten acceder rápidamente a los comandos relacionados con la actividad que se está 
realizando. Al hacer clic con el botón derecho del ratón en determinadas zonas de la 
pantalla se accede a diferentes menús contextuales. 
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Capítulo 2 – Dibujo Básico 
 

Sistemas de Coordenadas 
 
Dado que AutoCAD es un programa de diseño sectorizado, la creación y edición de los 
objetos toma lugar en el plano cartesiano y por ende todas las entidades tienen una posición 
específica en el espacio cartesiano. De aquí en adelante un "objeto" se refiere a cualquier 
entidad que se ha creado en AutoCAD. Ejemplos de objetos son: líneas, círculos, textos, 
sólidos, superficies, imágenes, etc. 
 
A continuación, se muestra la disposición clásica del plano XY en coordenadas cartesianas 
y polares. Del cuadrante en el que se creen los objetos dependerá el signo de las 
coordenadas, a la vez que la dirección para las rotaciones será en base al sentido contrario 
de las manecillas del reloj (antihorario) para que los grados sean positivos, por lo cual es 
importante la cabal comprensión de esta convención para la edición y creación de los 
objetos. 
 

 
 
Los sistemas de coordenadas cartesianas tienen 3 ejes X, Y y Z. Cuando se escriben 
valores para estas coordenadas, se indica la distancia de un punto (en unidades) y su 
sentido (+ o -) a lo largo de los ejes X, Y y Z con respecto al origen del sistema de 
coordenadas (0, 0,0). 
 
En un espacio bidimensional, los puntos se representan en el plano XY denominado 
también plano de construcción. Este plano es similar a una hoja cuadriculada. El valor en X 
de una coordenada cartesiana indica la distancia horizontal y el valor Y la vertical. El punto 
de origen (0,0) es el punto de intersección de los dos ejes. 
 
Con referencia a esta forma de trabajo, AutoCAD permite trabajar con 2 tipos de 
Coordenadas Cartesianas: 
 

• Coordenadas Absolutas 
• Coordenadas Relativas 
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Coordenadas Absolutas 
 
Las Coordenadas Absolutas, se basan en el punto 0,0 real, como origen, donde X y Y se 
interceptan. Los puntos X y Y sobre el plano cartesiano son conocidos en forma absoluta.  
 
Por ejemplo, si se indica la coordenada (3,4) significa que en X hay una distancia de 3 
unidades desde el punto 0 de X, y el punto 4 significa que hay una distancia de 4 unidades 
desde el punto 0 de Y. 
 
Rectangulares (X, Y). 

 
 
Coordenadas Relativas 
 
Las Coordenadas Relativas, se basan en la distancia que se quiere tener entre un punto 
conocido y un nuevo punto de ingreso de datos. Para definir las coordenadas relativas debe 
colocarse el signo @ antecediendo a los valores X, Y. 
 
Nota. - A partir de la versión 2006 de AutoCAD, si se activa en la Barra de Estado la 
herramienta DYN (Entrada Dinámica de Datos), este método de coordenadas se encontrará 
activo sin necesidad de escribir la @ para la entrada de datos. Además, que si se encuentra 
activa la herramienta DYN, permite trabajar con ambos tipos de coordenadas tanto 
Absolutas como Relativas sin ninguna restricción. 
 
En el ejemplo está definida la coordenada @5,0 la cual indica que hay una distancia de 5 
unidades desde el punto conocido como –2,1, en X y la distancia en Y es 0 desde el punto 
conocido como –2,1. 
 
Rectangulares relativas @ (X, Y) 

 
 
Nota. - Las coordenadas absolutas pueden utilizarse cuando el punto X, Y es totalmente 
conocido por el usuario. Las coordenadas relativas son útiles cuando el usuario ingresara 
un punto sobre el plano que no conoce con exactitud, pero toma como referencia un punto 
sobre un objeto existente. 
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Coordenadas Polares 
 
Estas coordenadas se utilizan para definir la longitud y ángulo específico de un objeto. 
 
Por ejemplo, la coordenada @7<45 indica que el objeto a dibujarse tendrá una longitud de 
7 unidades y un ángulo de inclinación de 45 grados. 
 

 
 
Nota. - A partir de la versión 2006 de AutoCAD, si se activa en la Barra de Estado la 
herramienta DYN (Entrada Dinámica de Datos), este método de coordenadas se encontrará 
activo sin necesidad de escribir la @ para la entrada de datos. Símbolo 
 
Además, que si se encuentra activa la herramienta DYN, permite trabajar con ambos tipos 
de coordenadas tanto Absolutas como Relativas sin ninguna restricción. 
 
Coordenadas del Usuario 
 
Dependiendo de la ubicación del icono que marca el origen del plano cartesiano, se pueden 
establecer dos sistemas trabajo; uno fijo, llamado Sistema Mundial de Coordenadas (WCS), 
y otro móvil que es el Sistema de Coordenadas definido por el Usuario (UCS). 
 
Sistema Mundial de Coordenadas (World Coordinate System (WCS)) 
 
La localización de todos los objetos de AutoCAD está referida a este sistema de 
coordenadas cartesianas. Es único y en base a él se pueden crear otros sistemas de 
coordenadas definidos por el usuario. 
 

 

El WCS, dentro de AutoCAD lo podemos identificar mediante el 
símbolo de coordenadas X, Y que se encuentra en la esquina 
inferior izquierda del área de trabajo. 
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Sistema de Coordenadas del usuario (User's Coordinate System (UCS)) 
 
El usuario tiene la posibilidad de definir sistemas de coordenadas adicionales al WCS. El 
determina la orientación de los ejes y la localización del nuevo origen, que puede estar 
referida al WCS o a otro UCS. Se pueden crear tantos como sea necesario.  
 
El icono UCS se muestra de forma diferente cuando se está trabajando en el Sistema 
Mundial de Coordenadas (WSC) frente a un Sistema de Coordenadas del usuario (UCS). 
El icono UCS para el Sistema Mundial de Coordenadas (WSC) contiene una pequeña caja 
en el origen de los ejes X y Y. 
 

 
 
La Imagen de abajo muestra una forma de generar un nuevo sistema de coordenadas, que 
tiene como referencia u origen (0,0) el centro de la circunferencia 

 
 

Inicio de un dibujo 
 
Un método rápido para iniciar un dibujo nuevo es partir de cero utilizando los parámetros 
de un archivo de plantilla de dibujo predefinida. Un archivo de plantilla de dibujo contiene 
parámetros estándar, predefinidos y normalizados (Layers, Tipos de texto, Tablas, Cotas, 
Layouts, etc.). 
 

1. Haga clic en la Barra de herramientas de acceso rápido ➤ Nuevo. 

 
2. Se abrirá el cuadro de dialogo “Select Template”. 
 
3. Seleccione una de las opciones de la lista, cabe mencionar que AutoCAD en 

2D y 3D, trabaja con dos archivos de plantilla principales (.dwt). Uno en un 
sistema métrico ISO de estandarización y el otro en un sistema Imperial o 
inglés: 
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• Imperial (acad.dwt) 
• Métrico (acadiso.dwt) 

 
 

4. Haga clic en al botón Abrir (Open) del cuadro de dialogo “Select Template”. 
El dibujo se abre con los parámetros por defecto. 

 
Nota. - La plantilla que AutoCAD carga por defecto al hacer clic en el icono que abre el 
programa es la plantilla acadiso.dwt. 
 

Apertura de un dibujo 
 
Pueden utilizarse diversos métodos para localizar y abrir los dibujos, incluso los dañados. 
 
Los dibujos se abren para trabajar con ellos, del mismo modo que en las aplicaciones de 
Windows. Además, puede escoger entre varios métodos alternativos. 
 
Para abrir un dibujo existente, es posible: 
 

• Seleccionar Abrir (Open) en el menú   
 

• Haga clic en la Barra de herramientas de acceso rápido ➤ Abrir    

 
En cualquiera de estos dos casos se mostrará el cuadro de diálogo “Select File”. 
 

Nota: También se puede abrir una plantilla desde la pestaña 
de START y desplegando el listado de Templates precargado 
en AutoCAD. 
 
Si da clic sobre el botón Start Drawing, abrirá dibujo nuevo 
basado en la última plantilla seleccionada previamente y con 
la que haya estado trabajando. 
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Otra Opción para abrir un dibujo existente es: 
 
• Hacer doble clic en un dibujo en el Explorador de Windows para ejecutar AutoCAD® 
y abrir ese dibujo. Si el programa ya está en ejecución, el dibujo se abrirá en la sesión actual 
en lugar de en una segunda ventana de la sesión. 
 

Guardado de un dibujo 
 
Los archivos de dibujo que se vayan a utilizar más tarde se guardan igual que en otras 
aplicaciones de Windows. AutoCAD incorpora funciones de guardado automático y otras 
opciones para guardar archivos. La extensión con la que se guardan los archivos de 
AutoCAD es DWG. 
 
Puede guardar un dibujo en una versión anterior de AutoCAD en formato de dibujo (DWG) 
o bien del formato de intercambio de dibujos (DXF), o guardar un dibujo como un archivo 
de plantilla que podrá usar para iniciar nuevos dibujos (DWT). 
 
Para guardar un dibujo, es posible: 
 

• Usar “Save” o “Save As” en el menú   
 

• Haga clic en la Barra de herramientas de acceso rápido ➤  Save o  Save 

As. 
 
En cualquiera de estas opciones se muestra el cuadro de diálogo “Save Drawing As”. 
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Con esto ya está en posibilidades de Iniciar nuestros dibujos dentro de AutoCAD. 
 
Cabe mencionar que existen herramientas avanzadas para apertura y guardado de dibujos, 
así como la posibilidad de generar Plantillas de Dibujo personalizadas; que se abordaran 
en capítulos posteriores, ya que se tenga cierto dominio del programa y bien claros los 
conceptos para trabajar con dichas herramientas. 
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Capítulo 3 – Comandos de dibujo 
 
Objetivos 
 
Al terminar este capítulo, estará en capacidad de: 
 

• Crear Líneas, Círculos y Polígonos. 

• Crear Geometrías Básicas. 

• Conocerá el uso y aplicación de los comandos de Edición de Objetos. 

• Tendrá el conocimiento de los comandos de Dibujo y Edición para poder realizar 
cualquier Proyecto. 

• Conocerá el uso y aplicación de las herramientas auxiliares de dibujo 
 

Creación y Edición de Formas y Geometrías Básicas 
 
Aprender a crear la geometría básica es fundamental para el éxito en el software. A medida 
que domina la creación de la geometría básica, usted puede pasar a la creación de tipos 
de objetos más avanzados. 
 

 
 

Comandos de Dibujo 
 
Con AutoCAD podemos crear una amplia gama de objetos, desde líneas, y círculos hasta 
curvas spline y elipses. El dibujo se lleva a cabo mediante la precisión de puntos haciendo 
uso del mouse o introduciendo los valores de coordenadas. 
 
Desde la pestaña de Home, en el panel Draw, puede acceder a todos los comandos de 
Dibujo en 2D que ofrece AutoCAD. 
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Antes de iniciar nuestros trazos cabe aclarar que, sin excepción, los comandos de Dibujo 
siempre pedirán de inicio un punto de referencia para poder comenzar los trazos, no 
importando el comando de que se trate.  
 
Dicho punto de referencia puede estar dado por coordenadas “X, Y” (si cuenta con ellas) o 
bien puede ser un clic en cualquier parte del área de trabajo (Model Space), lo mismo para 
siguientes puntos, centros, etc. Además, es importante recordar que las instrucciones del 
programa se   mostrarán siempre en la línea de comando o bien si se encuentra activa la 

Herramienta (DYN) aparecerán en el puntero . 
 
Otra cosa importante que debemos saber es que algunos comandos cuentan con 
herramientas adicionales para realizar operaciones adicionales; dichas herramientas están 
contenidas dentro de corchetes. 
 

 
 
Cuando se utiliza la entrada dinámica (DYN), la selección de las opciones puede ser hecha 
por 2 métodos (esto aplica para todas las opciones de todos los comandos): 
 

1. Pulsando la flecha de acceso del teclado hacia abajo, que hace que aparezca 
una ventana de menú. 

 
 

2. Un clic con el botón derecho del mouse, que aparece una ventana emergente, 
para poder activar cualquiera de las opciones adicionales del menú 
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O bien escribiendo directamente en el teclado, la letra que aparezca en Mayúscula dentro 
de las opciones de dicho comando. 
 

 
 

Dibujo de Objetos Lineales (Line) 
 
La línea, es el objeto más básico. Puede ser un segmento o una serie de segmentos 
conectados. 
 
Como activar el comando de línea: 
 

 Line 
 

Ribbon: Pestaña Home ➤ Panel Draw ➤ Line 

Línea de Comando: Line (L) 
 
Con el comando Line se puede crear una serie de segmentos de línea continuos, cada 
segmento de línea se puede editar por separado ya que cada segmento es independiente. 
Se puede crear una secuencia de segmentos de línea de tal forma que se junten el primero 
y el último segmento de dicha secuencia (geometría cerrada). Utilice el comando de línea 
para crear una sola línea o varios segmentos de línea de un punto de partida a un punto 
final. 
 

 
 
La imagen siguiente muestra un segmento de línea que se dibuja con la interfaz de entrada 
dinámica (DYN), en donde se puede especificar la longitud y el ángulo del segmento, sin 
necesidad de utilizar la @. Desde la versión 2006 de AutoCAD el uso de @ se ha suprimido 

gracias a la  herramienta (DYN) que se encuentra en la Barra de Estado de AutoCAD, 
ya que permite configurar de manera predefinida al programa con el uso de coordenadas 
relativas descrito anteriormente. 
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UBICACIÓN 
 

 
 
Para verificar y tener la seguridad que la configuración de la herramienta DYN se encuentra 
en un sistema de coordenadas relativo; dar clic con el botón derecho del mouse sobre la 

 herramienta (DYN) que se encuentra en la barra de estado. 
 

Entrada de puntero (Enable Pointer Input) 
 

 
 

Una vez que aparece el menú Dynamic Input, del lado izquierdo en la opción “Enable 
Pointer Input” marcar la casilla (Como se muestra en la figura DYN1 lado izquierdo) e 
ingresar en la opción “Settings”. Inmediatamente aparecerá el menú de configuración 
(Figura DYN1). 
 
Cuando están activados la entrada de puntero y un comando, la ubicación de los punteros 
en cruz se muestra como valores de coordenadas en una información de herramientas 
situada cerca del cursor. 
 
Puede introducir valores de coordenadas en la información de herramientas en lugar de 
hacerlo en la línea de comando.  
 
Utilice los parámetros de entrada de puntero para cambiar el formato por defecto que tienen 
las coordenadas y para controlar la visibilidad de la información en la entrada de puntero. 
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Fig. DYN1 

 
Las imágenes anteriores muestran la configuración predefinida, que es la sugerida en la 
mayoría de los casos para trabajo en AutoCAD.  
 
Para el caso del formato de las Coordenadas; si se requiere trabajar con Coordenadas del 
tipo Absoluto y el DYN está activo y configurado con las opciones predefinidas.  
 
No es necesario cambiar la configuración de la herramienta, solo basta desactivar la 
herramienta directamente en la barra de estado o bien con la tecla F12 de nuestro teclado. 
 

Entrada de cota (Enable Dimension Input) 
 
La siguiente opción del menú Dynamic Input es “Enable Dimension Input”, ayuda a 
configurar la visibilidad de los campos de edición que mostrará AutoCAD al momento de 
ingresar los valores o bien cuando se realice alguna edición por medio de los grips. 
 
Si la entrada de cota está activada, la información de herramientas muestra valores de 
distancia y ángulo cuando un comando solicita un segundo punto. Los valores de la 
información de herramientas de cota cambian a medida que se desplaza el cursor. Pulse el 

tabulador del teclado  (TAB) para ir hasta el valor que desea modificar. La entrada de 
cota está disponible para todos los elementos de Dibujo. 
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La figura DYN2 muestra las opciones predefinidas de configuración, que es mostrar solo el 
campo de Longitud y Grados. Si por alguna razón requerimos visualizar campos 
adicionales, la opción 3 permitirá agregar más elementos visuales. 
 
 

   
Fig. DYN2 

 
 

 

 
 

La Figura muestra toda la información generada por el DYN al activar la Opción 3. 

1 
 
2 
 
3 
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Solicitudes Dinámicas (Dynamic Prompts) 
 
Cuando las solicitudes dinámicas están activadas, se muestran en una información de 
herramientas junto al cursor. Puede escribir una respuesta en la información de 
herramientas en lugar de hacerlo en la línea de comando. Pulse la tecla de flecha hacia 
abajo para ver y seleccionar opciones. Pulse la tecla de FLECHA ARRIBA para que 
aparezcan las entradas más recientes. 
 

 
 
La entrada dinámica de datos (DYN) permite además ver en el entorno gráfico, el poder 
ingresar tanto la longitud como los grados o en su caso los datos de la geometría a dibujar, 
así como la posibilidad de tener cerca del cursor las instrucciones de la línea de comando. 
 
Lo primero que se tiene que hacer es dar el valor de la longitud del segmento, sin utilizar el 
ENTER y después tenemos 2 formas de ingresar la dirección del segmento que está dada 
por los grados. 
 

• La primera opción es escribir el símbolo “<”  que se encuentra junto a la tecla 
“z” del lado izquierdo en el teclado.  

• La segunda opción sería por medio del tabulador del teclado (TAB).  
 
En cualquiera de los 2 casos se dan los valores de los grados del segmento (Ejemplo: 
45.37) y después de esto presionar ENTER para terminar la operación. 
 
Para el caso de trazos Rectos ya sea Horizontales o Verticales se activa la función de 
Ortogonales de AutoCAD con la tecla F8 o bien por medio de (ORTHO) que se 
encuentra en la barra de estado.
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Opciones del Comando Línea. 
 

 
 
Cuando se utiliza el comando de línea, las siguientes opciones están disponibles: 
 

Opción Descripción 

First Point Especifica el punto de inicio del segmento de línea. Este 
punto de inicio puede ser una coordenada específica” x, y” 
o bien un clic en cualquier parte del espacio de trabajo. 

Next Point Especifica el punto final del segmento de línea. Continúe 
especificando siguientes puntos para segmentos 
adicionales. Este punto Final puede ser una coordenada 
específica” x, y” o bien un clic en cualquier parte del 
espacio de trabajo. 

Undo Elimina el trazo hecho previamente 

Close Aparece únicamente cuando se han dibujado 2 segmentos. 
Usa el primer punto trazado hasta el siguiente punto del 
segmento actual, para crear un contorno cerrado de líneas 

 
A continuación, haremos una secuencia de datos para validar y verificar nuestra 
información. 
 
Paso 1 Se activa el comando de Línea 
 
Paso 2  Tras solicitud de primer punto “First Point” le asigna las coordenadas “X, Y” 
o bien dar un clic en cualquier parte del espacio de trabajo (Model Space). 

 
 
Paso 3  Tras la solicitud del siguiente punto “Next point”, ingresar la longitud 
del segmento y después con el tabulador o el símbolo “<” asignarle los grados (ejemplo 
5>45), o una coordenada cartesiana (ejemplo 5,10) o hacer clic sobre el punto donde se 
quiere definir el segundo punto. Para el caso de más segmentos repetir los Pasos 1 a 3 y 
finalmente dar ENTER para terminar. 
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Antes de continuar, debemos considerar nuevamente la herramienta (DYN) 
para la edición de objetos; así como las referencias de Objetos 
(OSNAP) para poder ubicar los trazos y puntos de referencia al editar los objetos 
por medio de los comandos del Panel de “Modify”. 
 

Entrada Dinámica de Datos (DYN) 
 
Como ya se ha mencionado, la entrada dinámica de datos permite en un entorno gráfico 
ingresar los valores de Longitud y Dirección (Grados). Pero además permite editar las 
propiedades de los objetos de manera gráfica y simplificada. 
 
La entrada dinámica proporciona una interfaz de comandos situada cerca del cursor que 
ayuda a mantener la atención centrada en el área de dibujo. 
 
Cuando la entrada dinámica está activada, las herramientas de información muestran en la 
proximidad del cursor datos que se actualizan dinámicamente a medida que el cursor se 
desplaza. Cuando un comando está activo, las herramientas de información proporcionan 
una ubicación que admite entradas del usuario.  
 
Las acciones necesarias para completar un comando o utilizar grip’s son similares a las de 
la línea de comando. La diferencia es que la atención se puede centrar en las proximidades 
del cursor. La entrada dinámica no está diseñada para reemplazar la ventana de comandos.  
 
 

 
 
Una vez dibujado cualquier objeto se puede seleccionar dándole un clic en cualquier línea 
que lo conforma, en ese momento aparecerán unos cuadros azules conocidos como Grips 
o Pinzamientos tal como se muestra en la siguiente figura. 
 
Los Grips son los puntos de referencia o selección de cualquier geometría. 
 
Estos también servirán de referencia, cuando se quiera continuar los trazos, encontrar los 
extremos, centros, tangencias, etc. Y podrán ser ubicados por medios de los OSNAPS 
(Referencias de Objeto). 
 
Para editar un objeto por medio de los grips, se realizará el siguiente procedimiento: 
 

1. Seleccionar el objeto 
2. Hacer click sobre el pinzamiento a editar 
3. Se muestra el número “0”. Tal como lo muestra la Fig.2 

DYN 
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Fig. 2 

 
4. Presionar la tecla TAB para cambiar al campo de longitud, y si se presiona una 

segunda vez cambiará al campo de los grados. Fig. 3 y Fig. 4. 
 
 
 
 
 
 
 
 
 
 
 
 

Fig 3     Fig. 4 
 

5. Si solo se requiere cambiar una sola variable, presionaremos el TAB hasta llegar al 
campo deseado, ingresar el valor y para finalizar la edición en cualquiera de los 
casos descritos, se presionará la tecla Enter. 

 
Algo importante de señalar es que cuando un objeto esta seleccionado y sólo se coloca el 
cursor sobre los grips de los extremos (sin dar clic); podremos visualizar las longitudes, 
radios, ángulos y demás valores con que cuenta el objeto seleccionado (Fig. 5). 
 

 
Fig. 5 

Fig. 3 Fig. 4 
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También es importante señalar que cuando se muestran los grips, y entrar a la herramienta 
de propiedades, podemos conocer las características geométricas más importantes del 
objeto seleccionado. 
 
Nota. - Cuando un objeto esta seleccionado y presionar la Tecla Suprimir (DEL) estaremos 
borrando dicho Objeto. Esta es la forma simplificada y mas usual de eliminar objetos en 
AutoCAD. 
 
Para ingresar a la paleta de propiedades, existen varias formas. La más rápida y sencilla 
es seleccionar el objeto del cual se quieren conocer sus propiedades y dar clic con el botón 
derecho del mouse; esto abrirá un menú de herramientas y seleccionaremos la opción 
“Properties” (propiedades), inmediatamente aparecerá la paleta de herramientas 
Propiedades. 
 

    
 
 
La paleta de propiedades brinda información muy importante del objeto. Esta información 
puede ser la longitud, los grados, área, perímetro, coordenadas de inicio y fin, etc. 
Dependiendo del objeto que este seleccionado. Además, desde esta paleta podemos 
modificar algunas de esas propiedades. Las celdas que aparecen en blanco son variables 
que puede modificar por el usuario, las que aparecen en gris, son variables del sistema y 
solo son de carácter informativo, que no permiten ninguna modificación. 
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Referencias de Objetos (OSNAP) 
 
Las referencias a objeto permiten dibujar y seleccionar los objetos con precisión, al activar 
el botón OSNAP, cuando comienza o continúa un trazo, el programa solicitará un punto de 
referencia. 

La herramienta  (OSNAP) la encontrara en la Barra de Estado. Y podra configurar de 
forma predefinida algunas referencias (las de mayor uso), para que no importando el 
momento siempre estén disponibles. Para activar o desactivar esta herramienta, también 
podemos usar la tecla F3. 
 
En el listado de opciones hacer clic sobre la opción que desea dejar activada, también 
puede escoger la opción Object Snap Settings… para entrar a la caja de dialogo Object 
Snap.  
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Si no quiere mantener activo el botón OSNAP, puede activar la referencia a objeto que 
necesite en el momento que está realizando el trazo, para esto debe presionar 
simultáneamente la tecla SHIFT y el botón derecho del Mouse. 
 
Automáticamente aparecerá el menú de OSNAP (Fig. 3) y la entidad seleccionada, será la 
única disponible al tocar los objetos. 
 

    
 
 
A continuación, se presenta una tabla con la descripción de los OSNAPS, así como la 
simbología de cada uno dentro de AutoCAD. 
 
 

Nombre 
Símbolo 
Barra de 

Herramientas 

Símbolo 
en 

Operación 
Descripción Modo de uso 

Endpoint (Punto 
Final)   

Proyecta el cursor 
al extremo de 
líneas, arcos y 

polilíneas.  

Midpoint (Punto 
Medio)   

Proyecta el cursor 
a la mitad de 

líneas, arcos y 
polilíneas.  

Center (Centro) 
  

Proyecta el cursor 
al centro de un 
arco, círculo o 

elipse.  

Geometric 
Center (Centro 

Geométrico)   

Fuerza el cursor al 
centro de 

gravedad de las 
splines y polilíneas 

cerradas.  
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Node (Punto) 
  

Proyecta el cursor 
sobre un punto 

real. 
 

Quadrant 
(Cuadrante)   

Proyecta el cursor 
al cuadrante más 

cercano de un 
arco, círculo o 

elipse (los 
cuadrantes son las 

referencias a 0, 
90, 180 y 270 

grados) 

 

Intersection 
(Intersección)   

Proyecta el cursor 
al punto de 

intersección o 
cruce de objetos 

como líneas, 
círculos, arcos y 

splines. 

 

Extension 
(Extensión)   

Permite proyectar 
el trazo en la 

misma dirección, a 
partir del extremo 

de líneas y 
polilíneas y arcos, 

e iniciar en 
cualquier punto de 
esta trayectoria un 

nuevo trazo. 

 

Insertion 
(inserción)   

Proyecta el cursor 
al grip de un 

bloque, forma, 
texto, o atributo.  

Perpendicular 
(Perpendicular)   

Proyecta el cursor 
al punto 

seleccionado, con 
la característica de 
que siempre será 

a 90° del objeto de 
referencia. Este 
punto puede ser 
sobre el objeto, o 

bien en proyección 
imaginaria. Puede 

utilizarse con 
objetos como 

líneas, círculos, 
elipses, splines o 

arcos. 

 

Tangent 
(Tangente)   

Proyecta el cursor 
al punto de un 

círculo o arco que, 
al conectarlo al 
último punto, 

formará una línea 
tangente a dicho 

objeto. 
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Nearest 
(Cercano)   

Permite al cursor 
recorrer en su 

totalidad cualquier 
línea, círculo, 

elipse, spline o 
arcos. Y permite 

seleccionar 
cualquier punto 

durante la 
trayectoria. 

 

Apparent 
Intersection 
(Aparente 

Intersección) 
  

Proyecta el Cursor 
al punto 

imaginario en 
donde crucen 2 

objetos que 
extienden 

imaginariamente 
su trazo. Los 

objetos pueden 
ser líneas, 

círculos, arcos y 
splines 

 

Parallel 
(Paralela)   

Permite generar 
un trazo en forma 

paralela con 
respecto de 

alguna línea o 
polilínea existente. 

 

 
IMPORTANTE: Las referencias a objeto sólo funcionan si previamente ha sido activado un 
comando de dibujo o edición. 
 
Tanto DYN como OSNAP son herramientas que permiten hacer más rápido y sencillo el 
trabajo para la generación de nuestros dibujos. 
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Ejercicios 
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Dibujo de Círculos (Circle) 
  
Se pueden crear círculos por medio de distintos métodos. El método por defecto consiste 
en especificar el Centro y el Radio para la circunferencia. 
 
Al iniciar el comando círculo; se le pedirá que seleccione un punto que defina el centro de 
la circunferencia, y a continuación deberá especificar el radio.  Utilice los métodos de 
entrada de datos mencionados anteriormente para ingresar estos valores. 
 
En la siguiente imagen, el centro del círculo se ha seleccionado y se le pedirá especificar 
un radio. 
 

 
 
 
Como activar el comando Circle: 
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1. Ribbon: Pestaña Home ➤ Panel Draw ➤ Circle  o en Línea de comandos: 

Circle 
 

2. Cuando se utiliza el comando de círculo, las siguientes opciones están disponibles 
tanto en el menú como en la línea de comandos y corresponden a cada uno de los 
métodos de creación de círculos: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Especifique el centro y el radio (método por defecto). 

• Especifique el centro y el diámetro. 

• Defina la circunferencia del círculo mediante dos o tres puntos. 

• Cree un círculo tangente a dos objetos y especifique un radio. 

• Cree un círculo tangente a tres objetos existentes 
 

3. Escoger la opción requerida. 
4. Presionar Enter para terminar el comando. 

 
En la ilustración se muestran las opciones del comando para dibujar círculos por los 
diferentes métodos 
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Ejercicio 
 
Realizar la siguiente figura basada en círculos. 
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Dibujo de Rectángulos (Rectangle) 
 
El rectángulo en sus propiedades es considerado una Polilínea. 
 
Además, la forma en que se dibuja tiene como característica que la longitud (Length) 
siempre hace referencia al Eje “X” y el espesor o altura (Width) siempre hace referencia al 
Eje “Y” no importando la posición del Rectángulo. El método para la creación de un 
rectángulo es sencillo. 
 
Lo primero que se pide es especificar la primera esquina por medio de coordenadas “X, Y” 
o bien dando clic en la pantalla (1), arrastrar el cursor para que se forme una ventana, 
especificar la segunda esquina por medio de coordenadas “X, Y” o bien dando clic en la 
pantalla (2).  Otras opciones para crear rectángulos son Área, Dimensiones y Asignarle una 
Rotación. 
 

 

 
 
 
Como activar el comando: 
 

 
 

1.- Ribbon: Pestaña Home ➤ Panel Draw ➤ Rectangle o por Línea de Comando: Rectangle 

(Rec) 
 
El comando Rectangle muestra las siguientes opciones: 
 

• Chamfer: ángulos en las esquinas 

• Elevation: elevación (coordenada en Z) 

• Fillet: redondeo de las equinas 

• Thickness: asignar un grosor 

• Width: especificar la coordenada de ancho 

L = Eje x 

W = Eje y 
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Ingresar el valor de coordenada o hacer un clic en la pantalla para definir la primera esquina. 
Luego el comando pregunta la segunda esquina. En ese momento podemos pulsar la flecha 
hacia abajo o bien por medio de las opciones de la línea de comando y el teclado. 
 

 
 

Opción Descripción 

Area Permite dibujar un rectángulo mediante el área en las unidades de trabajo. 
El cálculo del área es basando en una dimensión, ya sea en el largo 
(length) o el ancho (width) del rectángulo. En donde length siempre hace 
referencia al Eje X y width al Eje Y 

Dimensions Permite establecer el largo (length) y el ancho (width) del rectángulo. En 
donde length siempre hace referencia al Eje X y width al Eje Y 

Rotation Esta opción permite asignar un ángulo de inclinación al rectángulo 

 

 
 
Nota.- La forma más rápida de dibujar un rectángulo es cuando selecciona la primera 
esquina del rectángulo, y si está activada la herramienta DYN; al preguntar por la otra 
esquina se le asignan los valores de L, W (X, Y) tal cual como si se ingresara una 
coordenada. (Ej. 100,80) y presionar ENTER para terminar. 
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Ejercicio 
Realizar la siguiente figura basada en rectángulos. 

 
 

Dibujo de Polígonos (Polygon)  
 
Los polígonos son considerados polylíneas cerradas con lados de igual longitud, se pueden 
dibujar polígonos desde 3 hasta 1024 caras.  
Con el comando Polygon dibujara de una forma sencilla cuadrados, triángulos equiláteros, 
octágonos, etc. 
 
Las figuras siguientes ilustran el dibujo de un polígono haciendo uso de los dos métodos 
disponibles.  
 
Centro: En las dos primeras figuras, el punto 1 es el centro del polígono mientras que el 
punto 2 define la longitud del radio, que se precisa con el mouse o introduciendo la distancia. 
Basado en la circunferencia un polígono puede ser:  
 
Inscrito. - Va desde el centro hasta la punta de cualquiera de los vértices del polígono. 
 
Circunscrito. - Va del centro hasta la mitad de sus caras. 
 
Arista: En la última figura se emplea el método de cara (Edge), pide un punto inicial y un 
punto final o la distancia de dicha cara. 
 

 
Como activar el comando:  
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1.- Ribbon: Pestaña Home ➤ Panel Draw ➤ Polygon   o por linea de commando 

Polygon 

   
2.- Al seleccionar el comando, lo primero que pedirá es dar el número de lados del polígono. 
 

 
 
3.- Después de asignar el número de lados deseado, presionar Enter y de inmediato pedirá 
definir el centro para el polígono (recordado que este centro podar ser por medio de un clic 
o bien asignarle las coordenadas x, y) o en su defecto seleccionar la opción para dibujarlo 
por medio de la longitud de la cara “Edge”. 
 

 
 
Si se requiere dibujar por medio del centro, el comando pedirá escoger cualquiera de los 2 
métodos geométricos para crear un polígono (Inscrito o Circunscrito) 
 

 
 
Si fuera el caso de dibujarlo por medio de la longitud de cara “Edge” pide un punto inicial y 
un punto final o la distancia de dicha cara. 
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Ejercicio 
Realizar la siguiente figura basada en polígonos. 
 

 
 

Dibujo de Polilíneas (Polyline) 
 

Una polilínea es una secuencia de líneas curvas o rectas, conectadas y creadas como un 
solo objeto. Esta forma de trabajo puede resultar importante, ya que un trazo puede ser 
muy grande y de formas variadas y para AutoCAD será considerado un solo objeto. Eso 
ayudará a quitarle peso al archivo.  
 
Una característica importante de la polilínea es que se puede dibujar de espesores 
diferentes.  
 
 

 
 

 
Las polilíneas en 2D sirven para definir contornos, áreas, rutas, etc.; además de que son la 
base para el trabajo en 3D.  Existen 2 tipos de polilíneas: 
 

• Polilíneas Abiertas. - Son aquellas en las que sus extremos (Inicio y Fin) no se 
unen entre sí. Para el caso de 3D las Polilíneas Abiertas servirán para generar 
SUPERFICIES. 

 

• Polilíneas Cerradas. - Son aquellas en las que sus extremos (Inicio y Fin) se unen 
entre sí, formando un polígono de cualquier forma. Para el caso de 3D las Polilíneas 
Cerradas servirán para generar SOLIDOS. 

 
Actualmente los únicos tipos de polilíneas que hemos trabajado son de tipo cerrado y han 
sido de forma natural, ya que como recordaremos tanto el Rectángulo, como el Polígono 
son considerados por AutoCAD como polilíneas. 
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Como activar el comando: 
 
  

1.- Ribbon: Pestaña Home ➤ Panel Draw ➤Polyline. ó por línea de comando: 

PL 
 
El proceso de creación de una polilínea es muy semejante a la forma de dibujar líneas, la 
diferencia radica en las opciones que ofrece el comando, ya que en el momento de dibujar 
permite configurar ciertas características, en cualquier caso, podemos cambiar después 
mediante la paleta de Propiedades. 
 
Cuando se utiliza el comando de polilínea, las siguientes opciones están disponibles: 
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Opción Descripción 

Halfwidth Permite asignarle a la polilínea un grosor variable (Figura 
Anterior) 

Arc Permite dibujar arcos tangentes a las componentes, ya 
sean líneas o arcos 

Line Esta opción permite regresar al trazo de líneas, cuando se 
trabaja con la opción de Arco. 

Width Permite asignarle a la polilínea un grosor Uniforme. 

 
Cuando ya existe una polilínea, el método para modificar las propiedades antes descritas; 
es por medio del cuadro de propiedades. 
 

 
 
Desde la Paleta Propiedades es posible modificar el grosor para cada uno de los segmentos 
de una polilínea. Y también asignarle un grosor general. 
 
 También permite conocer las coordenadas de cada vértice. Se le conoce como vértice a 
cada uno de los grips que definen los segmentos, que forman la polilínea.  
 

 



46 
 

 
 
Para editar una polilínea la forma simplificada es dar doble clic sobre ella y a diferencia de 
todos los demás objetos de dibujo, aparcera un menú en donde permite seleccionar las 
herramientas de edición para cambiar alguna de sus propiedades. 

 
 

 
 

 
Ahora una parte importante del trabajo con polilíneas es poder transformar los objetos que 
no fueron creados como polilíneas desde un principio; esto como ya se había comentado 
servirá para convertir en un solo elemento esos trazos que requieren por así llamarlo 
agruparse en uno solo, como es el caso de rutas, contornos, etc.   
 
Para realizar esta transformación se realiza un proceso que se conoce como editar una 
polilínea.  
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Editar Polilínea (PEdit) 
 
Como activar el comando: 
 

1.- Ribbon: Pestaña Home ➤ Panel Modify ➤Pedit.                  

Línea de Comando:  PEdit 
 
2.- Al activar el comando pedirá seleccionar una o varias polilíneas. 
 

 
 
 
3.- Si el objeto(s) seleccionado no es una polilínea, AutoCAD preguntara si lo queremos 
convertir en una polilínea. Le seleccionar Y (Yes) y enter, para aceptar. 
 

 
 
Se despliegan las opciones del comando Pedit 
 

 
 
Algunas de las opciones más importantes del comando Pedit son: 
 

• Join (Juntar): Combina una serie de objetos lineales finitos y objetos de curvas 
abiertas en sus puntos finales comunes para crear un único objeto 2D. En la figura, 
el segmento marcado con el 1 es el segmento seleccionado al iniciar el comando 
Pedit.  Escoger la opción Join en el menú 



48 
 

 
 
Seleccionar el segmento a juntar (el marcado como 2) para convertirlos en un solo 
elemento. 
 

 
 
 

• Fit: ajusta el radio de los segmentos de arco en una polílina 
 

 
• Decurve: convierte un segmento de arco en un segmento de línea 

 

• Spline: modifica la polilínea para darle una apariencia de curvas suavizadas. No la 
convierte en un spline 
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Algo que es muy importante señalar, es que si requerimos separar las polilíneas en cada 
uno de sus componentes y después las queremos unir nuevamente en polilíneas (Abiertas 
o Cerradas), tendremos que utilizar el comando “EXPLODE” el cual permite descomponer 
polilíneas, textos, bloques, sombreados, etc.  
 
Este proceso de unir y descomponer las polilíneas lo podemos hacer cuantas veces se 
requiera sin limitaciones. 
 
Nota.-  Las propiedades de grosor (width) de las polilíneas se verán alteradas al utilizar el 

comando Explode. 
 

Explotar o Descomponer (Explode) 
 
Permite descomponer los objetos seleccionados en sus elementos básicos. 
 
Como activar el comando: 
 

1.- Ribbon: Pestaña Home ➤ Panel Modify ➤Explode 

Línea de Comando:  X 
 
2.- Al seleccionar el comando, lo primero que tenemos que hacer es seleccionar los objetos 
a descomponer, una vez hecha la selección, debemos dar Enter.  
 
Este comando sirve para separar bloques, textos, arreglos, tablas, cotas, etc.  
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Dibujar líneas de Centro (Centerlines, Center Marks) 
 
Crea líneas o marcas de centro que quedan asociadas a la geomtría de elementos como 
rectángulos, polígonos, círculos y arcos. Cuando los elementos son modificados las líneas 
de centro se ajustan para poder mantenerse asociadas al centro del elemento. 
 
Estos comandos no reemplazan los métodos actuales de colocación de marcas de centro. 
 
Para dibujar las marcas o líneas de centro, los objetos a los que serán asociadas deben 
estar previamente dibujados. 
 
Para dibujar una marca de centro: 
 
Activar comando: 

Ribbon: Pestaña Annotate ➤ Panel Centerlines ➤Centermark   

Línea de Comando:  CENTERMARK 
 
Seleccionar el arco o círculo al que asociará la marca 
 
 

  
 
 
Para dibujar una línea de centro: 
 
Activar commando 

1.- Ribbon: Pestaña Annotate ➤ Panel Centerlines ➤Centerline   

 
Línea de Comando: CENTERLINE 

 
Seleccionar  la primera línea de un rectángulo, polígono o polylínea 
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Seleccionar  la segunda línea de un rectángulo, polígono o polylínea 
 

 
 
El resultado será una marca que coincide con el punto medio del delemento. 
 

 
 

Modificar Líneas de Centro 
 
Las líneas de centro están compuestas de varios elementos. Cada elemento de las líneas 
de centro puede controlarse en apariencia, tamaño, distancia con variables del sistema. La 
figura muestra los elementos que conforman las líneas de centro y el nombre de las 
variables que permiten modificar cada uno. 
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• CENTERLTYPE (tipo de línea de líneas de eje): Precisa el tipo de línea utilizado 
por las marcas de centro y los ejes. Esta variable de sistema acepta los siguientes 
valores: "." (usar actual), PorCapa o cualquier tipo de línea válido. 

 

• CENTEREXE (Líneas de Extensión): Controla la longitud de las extensiones de 
línea de centro. 

 

• CENTERCROSSSIZE (Marca de Centro): Determina el tamaño de la marca de 
centro asociativa. Una marca de centro tiene por defecto un tamaño relativo 
de 0.1x y una separación de 0.05x.  

 

• CENTERCROSSGAP (Distancia marca de centro y líneas de eje): Determina el 
espacio de separación entre la marca de centro y sus líneas de centro. 

 
Nota: Los parámetros de las variables de sistema CENTERCROSSGAP y 
CENTERCROSSSIZE están relacionados entre sí. Se recomienda que ambas variables de 
sistema utilicen el mismo tipo de valor (absoluto, relativo o "ByLineType"). 
 
También se puede modificar los elementos de las líneas de centro desde la paleta de 
propiedades. 
 
Para modificar las líneas de centro desde la paleta de propiedades: 
 

1. Seleccionar la línea de centro 
2. Hacer clic derecho sobre la pantalla, en el submenú escoger Properties 
3. Si la marca seleccionada pertenece a un elemento que está compuesto de líneas o 

polylíneas, sólo se puede modificar la longitud de las líneas de extensión. 
 

 
 

4. Si la marca seleccionada es de un arco o círculo, se puede modificar el tamaño de 
la marca de centro, la distancia entre las líneas de eje y la marca de centro, la 
longitud de las líneas de extensión. También se puede ocultar las líneas de 
extensión y las líneas de eje 
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Ejercicio Propuesto 
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Capítulo 4 – Comandos de Edición 
 

 AutoCAD permite modificar fácilmente el tamaño, 
forma y ubicación de los distintos objetos, así como 
sus Propiedades Generales o Particulares, por 
medio de dos métodos principales de edición.  
 
La primera forma de edición permite ejecutar un 
comando en primer lugar y a continuación debemos 
de seleccionar los objetos que se van a editar, o 
bien el otro método de edición será seleccionar 
primero los objetos y después iniciar el comando.  
 

Desde la pestaña de Home, en el panel Modify, puede ingresar a todos los comandos de 
Modificar en 2D que ofrece AutoCAD. 
 
Nota.- Para aplicar los comandos de edición, es muy importante seleccionar el o los objetos 
a modificar, así como los puntos base o de referencia. Debemos considerar nuevamente la 
herramienta “DYN” para la edición de objetos; así como las referencias de Objetos “OSNAP” 
para poder ubicar los trazos y puntos de referencia al editar los objetos por medio de los 
comandos del Panel de “Modify”.  
 

Selección de Objetos. 
 
AutoCAD tiene una amplia gama de herramientas y opciones que podrá utilizar cuando 
necesite seleccionar objetos para operaciones de edición. 
 
Selección de objetos individualmente 
 
La forma habitual de seleccionar un objeto en AutoCAD es dándole un clic en cualquier 
línea que lo conforma, en ese momento aparecerán unos cuadros azules conocidos como 
Grips o Pinzamientos tal como se muestra en la siguiente figura. 
 

Como respuesta a la solicitud “Select Objects” 
(Seleccione Objetos), se puede seleccionar uno o 
más objetos por separado, los objetos seleccionados 
aparecerán resaltados con tipo de línea discontinua y 
se mostraran sus respectivos Grips.  
 
Para remover objetos ya seleccionados, del conjunto 
de selección actual, es necesario presionar 

simultáneamente la tecla SHIFT  y el Click Normal 
(Izquierdo) del Mouse sobre el Objeto. 

 
Nota: para seleccionar objetos de forma individual haciendo clic sobre estos sin utilizar 
ninguna tecla o control adicional, la opción “Use Shift to add to selection” en la caja de 
dialogo de Opciones debe estar desactivada. 
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Al hacer clic sobre un pinzamiento en un objeto seleccionado puede mover el objeto o 
modificar su geometría según el pinzamiento seleccionado. Por ejemplo, al seleccionar el 
pinzamiento del punto medio de la línea indicada en la figura, podrá desplazar el elemento 
a otra coordenada. 
 

 
 
En el ejemplo, al seleccionar el pinzamiento del cuadrante del círculo, podrá cambiar el 
tamaño del elemento. 
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Selección de Objetos por Ventana. 
 
Para seleccionar objetos por medio de ventanas, se deben especificar esquinas opuestas 
que definan un área rectangular. Para ello solo es necesario dar clic en el área de trabajo y 
arrastrar el puntero; aparecerá un rectángulo que tiene un color de fondo, este color puede 
variar de acuerdo al tipo de ventana de selección del que se trate. Y presionar nuevamente 
clic en la esquina opuesta para terminar con la selección. 
 
Para el caso de selección por ventanas, existen 3 tipos: 
 

• CROSSING.- Aparece cuando presiona clic en el área de trabajo y se arrastra el 
puntero de Derecha a Izquierda. Su característica principal es visualizar un área 
rectangular con un color verde de fondo y el contorno de línea punteada (Fig. 1). 

 
En este método de selección, solo basta que la 
ventana de Crossing toque los objetos para que 
estos queden seleccionados. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

• WINDOW.- Aparece cuando da clic en el área de trabajo y se arrastra el puntero de 
Izquierda a Derecha. Su característica principal es visualizar un área rectangular 
con un color azul de fondo y el contorno de línea continua (Fig. 2). 

 
En este método de selección, se necesita que la 

ventana contenga en su totalidad los objetos 
para que estos queden seleccionados. Es decir, 
Solo se seleccionarán los objetos que entren por 

completo en la ventana definida. 
 
 
 
 
 
 
 
 

 

• WINDOW LASSO.- Aparece cuando da clic en el área de trabajo y mantiene 
presionado del botón izquierdo del mouse, luego se arrastra el puntero de Izquierda 

Click 
2 

Fig. 2 

Click 2 

Window 

Click 
1 

Click 1 

Crossing 

Fig. 1 
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a Derecha o viceversa. El área se genera de forma irregular con un color azul de 
fondo si la selección va de izquierda a derecha, o verde si la selección se hace de 
derecha a izquierda. 
 

 

    
Window Lasso izquierda a derecha  Window Lasso derecha a izquierda  

 

Borrar Objetos (Erase) 
 
Permite eliminar objetos del área de dibujo. En la mayoría de los casos este comando se 
sustituye por la tecla DEL (SUPR). 
 
Como activar el comando: 
 

1.- Ribbon: Pestaña Home  ➤ Panel Modify ➤ Erase 

Línea de Comando: Erase (E) 
 
2.- Activar el comando, e inmediatamente seleccionemos los objetos a borrar. Una vez 
realizada la selección presionar Enter y los objetos serán eliminados. 
 
Existen otras formas de Borrar sin utilizar directamente el comando Erase, estas pueden 
sustituir al 100% dicho proceso. Una de ellas y la más común es cuando un objeto esta 
seleccionado y presionar la Tecla Suprimir, estaremos borrando dicho Objeto.  
 
Nota.- Se pueden restituir los objetos borrados con el comando UNDO (Deshacer). El 
comando OOPS restituye todos los objetos borrados recientemente con el comando 
ERASE.  
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Mover o Desplazar Objetos (Move) 
 
Con este comando podemos cambiar los objetos de posición, se puede hacer con precisión 
utilizando valores de coordenadas y referencia a objetos (Osnap). AutoCAD ubica los 
objetos sin que ello repercuta en su orientación o tamaño. 
 
Como activar el comando: 
 

1.- Ribbon: Pestaña Home  ➤ Panel Modify ➤ Move 

Línea de Comando: Move (M) 
 
 
2.- Tras elegir el comando MOVE, se seleccionan él o los objetos a desplazar, presionar 
Enter. Después se selecciona el punto base.  
 
El punto base es la referencia a partir de la cual se desplazarán los objetos, y por último el 
segundo punto para la nueva ubicación del objeto. 
 

 
 

Copiar Objetos (Copy) 
 
Este comando permite crear objetos idénticos a los objetos seleccionados, se puede hacer 
con precisión utilizando valores de coordenadas y referencia a objetos (Osnap). AutoCAD 
ubica los objetos sin que ello repercuta en su orientación o tamaño. 
 
Como activar el comando: 
 

  

1.- Ribbon: Pestaña Home  ➤ Panel Modify ➤ Copy 

Línea de Comando: Copy (Co) 
 
Tras elegir el comando COPY, se seleccionan él o los objetos a copiar, presionar Enter. 
Después se selecciona el punto base. El punto base es la referencia a partir de la cual se 
copiaran y colocaran los objetos  y por último el segundo punto para la colocación del objeto. 
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Para el caso del comando copiar, se puede colocar varias veces el mismo objeto sin 
necesidad de repetir el comando. Para finalizar el comando solo es necesario presionar la 
tecla Escape (ESC). 
 

Girar o Rotar (Rotate) 
 
Con este comando puede girar los objetos en torno a un punto base, para determinar un 
ángulo de rotación escribir el valor del ángulo o especifique un segundo punto.  
 
Nota.- Recordemos que en AutoCAD los grados giran en el sentido contrario de las 
manecillas del reloj. 
 
Como activar el comando: 
 

   

1.- Ribbon: Pestaña Home  ➤ Panel Modify ➤ Rotate 

Línea de Comando: Rotate (Ro) 
 
Tras elegir el comando ROTATE, se seleccionan él o los objetos a Rotar. Después se 
selecciona el punto base, y finalmente se asigna el ángulo o bien la referencia de giro 
(Segundo Punto) 
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Espejo o Simetría (Mirror) 
 
Este comando sirve para crear imágenes simétricas de los objetos. Resulta útil para crear 
objetos simétricos ya que puede dibujar rápidamente la mitad del objeto y después reflejarlo 
en vez de dibujar el objeto entero. Se pasa de un objeto a otro sobre un eje denominado 
eje de simetría o línea de espejo para crear una imagen reflejada. 
 
Nota.- Es importante señalar que por medio del comando de espejo se puede reflejar 
cualquier objeto que se encuentre en las áreas de trabajo (Textos, Tablas, Bloques, etc.) 
 
Como activar el comando: 
 

  

Ribbon: Pestaña Home  ➤ Panel Modify ➤ Mirror 

Línea de Comando: Mirror (Mi) 
 
1. Tras elegir el comando MIRROR, se selecciona él o los objetos, dar Enter. 

 

 
 
2. Inmediatamente el comando pedirá el Primer Punto de la línea de Espejo, Definir la 

línea de espejo o simetría. 
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3. Inmediatamente el comando pedirá borrar los objetos originales (Esta opción la 
pregunta, por si solo queremos cambiar la vista del objeto seleccionado o bien si 
queremos conservar el objeto original y la simetría), según sea el caso seleccionar 
Si (Y) o No (N) y finalmente presionar Enter.  

 

 
 

Cortar (Trim) 
 
Este comando permite cortar objetos. Para poder generar el corte los objetos necesitan 
estar interceptados y definir cuál de ellos será el objeto cortante.  
 
Nota.- Si presiona la tecla de SHIFT y selecciona algún objeto en lugar de cortar extenderá 
los objetos a un objeto limitante. 
 
Como activar el comando: 
 

  

1.- Ribbon: Pestaña Home  ➤ Panel Modify ➤ Trim 

Línea de Comando: Trim (Tr) 
 
Para trabajar con el comando cortar, tenemos 2 modos de trabajo: 
 

• Modo 1 seleccionando objetos cortantes: 
 

o Ejecutar el comando. 
o Seleccionar los objetos cortantes. Los que se utilizarán como fronteras de 

corte (marcados en azul) 
 

 
 

o Presionar ENTER 
o Seleccionar el objeto a recortar, debe estar entre las fronteras de corte 

seleccionadas en el paso anterior 
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o El resultado 
 

 
 

Nota.-  Se pueden borrar varios trozos de diferentes objetos, siempre y cuando los objetos 
corten con el objeto de referencia. 

 
o Pulsar ESC para finalizar el comando. 

 

• Modo 2, seleccionando todos los objetos: 
 

o Ejecutar el comando. 
 

o Seleccionar todos los objetos y presionar enter 
 

 
 

o Seleccionar los segmentos a recortar. Los objetos deben estar interceptados 
con los elementos que forman fronteras de corte. 
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El resultado 
 

 
Nota.- Se pueden borrar varios trozos de diferentes objetos, siempre y cuando los objetos 
corten con el objeto de referencia. 

 
 
Ejercicio propuesto 
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Ejercicio: 
 
Dibujar los polígonos con las medidas correspondientes y generara las Figuras de abajo 
con el comando Cortar (Trim) 
 

 
 
 

Alargar o Extender (Extend) 
 
El comando podrá alargar o proyectar objetos de modo que estos finalicen precisamente 
en las aristas de los contornos definidos por otros objetos. 
 
Nota.- Al presionar la tecla de SHIFT, la función del comando cambiara a generando cortes 
como lo hace el comando de TRIM 
 
El comando extender (EXTEND) funciona de la misma forma que el comando cortar (TRIM).  
 
Como activar el comando: 
 

1.- Ribbon: Pestaña Home  ➤ Panel Modify ➤ Extend 

Línea de Comando: Extend (Ex) 
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Para trabajar con el comando extender, tenemos 2 modos de trabajo: 
 

• Modo 1 seleccionando objetos de proyección: 
o Ejecutar el comando. 

 
o En la línea de comando aparece: - Designe objetos o < seleccionar todo >: 

 

 
 

o Seleccionar los objetos que serán tomados como fronteras de proyección. 
 

o Damos ENTER 
 

 
 

o En la línea de comando aparece: - Designe objeto a alargar o recortar o 
 [Borde / Captura Proyección / Arista / borrar / deshacer]: 
 

 
 
 

o Hacer clic sobre la orilla y el lado del objeto que se desea extender. 
 

 
Nota.- Se pueden proyectar varios trozos de diferentes objetos, siempre y cuando los 
objetos se proyecten hacia el objeto de referencia. 

 
o Pulsar ESC para finalizar el comando. 



66 
 

• Modo 2 seleccionando todos los objetos: 
 

o Ejecutar el comando. 
 

o En la línea de comando aparece: - Designe objetos o < seleccionar todo >: 
 

 
 

o Damos ENTER 
Con esto, se seleccionan todos los objetos del dibujo como fronteras de 
proyección. 
 

 
 

o En la línea de comando aparece:- Designe objeto a alargar o  recortar o 
 [Borde / Captura Proyección / Arista / borrar / deshacer]: 

 

 
 

o Hacer clic sobre la orilla y el lado del objeto que se desea extender. 
 

   
 

Nota.- Se pueden proyectar varios trozos de diferentes objetos, siempre y cuando los 
objetos se proyecten hacia el objeto de referencia. 

 
o Pulsar ESC para finalizar el comando. 
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Empalme o Redondeo (Fillet) 
 
Permite redondear las esquinas formadas por los objetos seleccionados, así como unir 
mediante un arco los objetos seleccionados. Los objetos deben ser: líneas, círculos, arcos, 
polilíneas (segmentos rectos). 
 
 
Como activar el comando: 
 

1.- Ribbon: Pestaña Home ➤ Panel Modify ➤ Fillet 

 
Línea de Comando: Fillet (F) 

 
 

 
o Ejecutar el comando. 

 
o En la línea de comando aparece: -Designe primer objeto o [ Deshacer / Polilínea / 

Radio / Recortar /Múltiple]:  
 

o  Escoger la opción Radio: R y damos Enter. 
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o En la línea de comando aparece:  -Precise radio de empalme: 
 

 
 

o Introducir el valor numérico del radio y damos Enter. 
 

o En la línea de comando aparece: -Designe primer objeto o [ Deshacer / Polilínea / 
Radio / Recortar /Múltiple]: 

 
o Hacer clic sobre uno de los objetos a empalmar. 

 
o  En la línea de comando aparece: -Designe segundo objeto o use la tecla SHIFT 

para aplicar esquina: 
 

 
 
Nota.- Al presionar la tecla de SHIFT, la función del comando cambiara a generar o 
completar las esquinas en lugar de colocar un redondeo. 

 
Si utilizamos un radio con valor = 0 (Cero) la función del comando cambiara a generar o 
completar las esquinas en lugar de colocar un redondeo. 
 

o Hacer clic sobre el otro objeto a empalmar. El comando finaliza en automático. 
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Cuando en la línea de comando aparece: -Designe primer objeto o [ Deshacer / Polilínea / 
Radio / Recortar /Múltiple]. Recordemos que las opciones que aparecen en los corchetes 
son más herramientas que permite utilizar el comando. 
 
 

 
 
Estas herramientas sirven para: 
 

Opción Descripción 
Polyline Permite realizar, de forma simultánea, los empalmes de los segmentos 

rectos de una polilínea. 
Radius Permite dimensionar el radio del empalme. 

Trim Permite controlar si, al efectuar el empalme, se recortan o no los objetos 
seleccionados. 

Multiple Permite realizar varios empalmes sin finalizar el comando, 
permaneciendo disponibles las demás opciones.  
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Chaflan (Chamfer) 
 
Permite biselar las esquinas formadas por los objetos seleccionados. Los objetos deben 
ser: líneas, círculos, arcos, polilíneas (segmentos rectos). 
 
Como activar el comando: 
 

    

1.- Ribbon: Pestaña Home  ➤ Panel Modify ➤Chamfer 

 
Línea de Comando: Chamfer (Cha) 
 
 

o Ejecutar el comando. 
 

o En la línea de comando aparece: - Designe la primera línea o [Deshacer / Polilínea 
/ Distancia /Angulo / Recortar / Método / Múltiple]: 
 

 
 

o Escoger la opción Distancia: D y damos Enter. 
 

o En la línea de comando aparece: - Precise primera distancia de chaflán: 
 

 
 

o Introducir el valor numérico de la primera distancia del chaflán y damos Enter. 
 

o Precise segundo distancia de chaflán: 
 

 
 
 

o Introducir el valor numérico de la primera distancia del chaflán y damos Enter. 
 

o En la línea de comando aparece: -Designe la primera línea o [ Deshacer / Polilínea 
/ Distancia /Angulo / Recortar / Método / Múltiple]: 
 



71 
 

 
 
 

o Hacer clic sobre una de las líneas de la esquina. 
 

o En la línea de comando aparece: -Designe segunda línea o use la tecla SHIFT 
para aplicar esquina: 
 

 
 

 
Nota.- Al presionar la tecla de SHIFT, la función del comando cambiara a generar o 
completar las esquinas en lugar de colocar un chaflán. 

 
Si utilizamos la distancia 1 y 2 valor = 0 (Cero) la función del comando cambiara a generar 
o completar las esquinas en lugar de colocar un chaflán. 
 

o Hacer clic sobre la otra línea de la esquina. El comando finaliza en automático. 
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Cuando en la línea de comando aparece: - Designe la primera línea o [Deshacer / Polilínea 
/ Distancia /Angulo / Recortar / Método / Múltiple]. Recordemos que las opciones que 
aparecen en los corchetes son más herramientas que permite utilizar el comando. 

 

 
 
 

Estas herramientas sirven para: 
 

Opción Descripción 

Polyline Permite realizar, de forma simultánea, los chaflanes de los segmentos 
rectos de una polilínea. 

Distance Permite dimensionar el chaflán mediante dos distancias. 
Las distancias se aplicarán en el mismo orden en el que se hayan 
definido los objetos que forman la esquina. (Distancia 1 = Línea 1 ; 
Distancia 2 = Línea 2) 

Angle Permite dimensionar el chaflán mediante una distancia y un ángulo. 

Trim Permite controlar sí, al efectuar el chaflán, se recortan o no los objetos 
que forman la esquina. 

Method Permite establecer el método empleado, por defecto, para realizar el 
chaflán: dos distancias o distancia y ángulo. 

Multiple Permite realizar varios Chaflanes sin finalizar el comando, 
permaneciendo disponibles las demás opciones.  
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Explotar o Descomponer (Explode) 
 
Permite descomponer los objetos seleccionados en sus elementos básicos. 
 
Como activar el comando: 
 

1.-Ribbon: Pestaña Home ➤ Panel Modify ➤Explode 

Línea de Comando: Explode (X) 
 
 
Al seleccionar el comando, lo primero que tenemos que hacer es seleccionar los objetos a 
descomponer, una vez hecha la selección, damos Enter.  
 
Nota.- Este comando sirve para separar bloques, textos, arreglos, tablas, cotas, etc. 
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Desfase (Offset) 
 
Con el comando OFFSET crea un objeto cuya forma es paralela a la forma de un objeto 
designado. El comando permite crear objetos equidistantes respecto a los elementos 
seleccionados. 
 
Los objetos pueden ser: líneas, círculos, arcos, polilíneas o splines. 
 
 
Como activar el comando: 
 

1.- Ribbon: Pestaña Home ➤ Panel Modify ➤Offset 

Línea de Comando: Offset (O) 
 
 

o Ejecutar el comando. 
 

o En la línea de comando aparece: -Precise distancia de desfase o [Punto a atravesar 
/ Borrar / Capa]: 

 

 
 

o Introducir la distancia a la que se desea obtener el objeto equidistante. 
 

o En la línea de comando aparece: -Designe objeto a desplazar o [Salir / Deshacer]. 
 

 
 

o Hacer clic sobre el objeto origen. 
 

o En la línea de comando aparece: - Precise punto en lado de desplazamiento o [Salir 
/ Múltiple /Deshacer]. 
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o Hacer clic en un punto cualquiera del lado en el que se desea el nuevo objeto 
(Derecha, Izquierda, Arriba, Abajo del objeto origen). 

 
o Pulsar ESC para finalizar el comando. 

 

 
 
 
Cuando en la línea de comando aparece: -Precise distancia de desfase o [Punto a atravesar 
/ Borrar / Capa]. Recordemos que las opciones que aparecen en los corchetes son más 
herramientas que permite utilizar el comando. 
 

 
 
 
Estas herramientas sirven para: 
 
 

Opción Descripción 
Through Permite introducir un punto por el que pasará el nuevo objeto 

equidistante. Este punto es mejor conocido como referencia. 

Erase Permite borrar el objeto origen, después de efectuar la equidistancia. 
Con esta opción solo parece que aumenta o disminuye su tamaño, o 
bien solo modifica su posición según sea el caso. 

Layer Permite incluir el nuevo objeto dentro de la misma capa que el objeto 
origen o dentro de la capa actual. 
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Matriz (Array) 
 
Creación de copias rectangulares y polares (Array) 
 
Se pueden crear copias de objetos en un patrón rectangular o polar (circular). En las copias 
rectangulares, podrá controlar el número de filas y columnas a la distancia que debe medir 
entre ellas. En el caso de las polares, podrá controlar el número de copias de los objetos 
que se crearan a partir de un punto base de giro. 
 
A diferencia de TODAS las otras versiones de AutoCAD el Array a partir de la versión 2012. 
Es diferente tanto en aplicación como en edición. 
 
Como activar el comando: 
 

  

1.- Ribbon: Pestaña Home ➤ Panel Modify ➤Array 

Línea de Comando: Array (Ar) 
 
 
Copias Rectangulares (Rectangular Array) 
 
 
AutoCAD Construye copias rectangulares a lo largo de una línea base definida por el ángulo 
de rotación de resolución actual. Por defecto, dicho ángulo viene definido con el valor cero 
lo que supone que las filas y columnas sean ortogonales con respecto a los ejes X e Y. el 
parámetro por defecto de la dirección del Angulo es 0. 

 
Para el caso de poder Trabajar, con el comando Array tomaremos 
este cuadrado como ejemplo. 
 
Tiene 20 unidades de alto por 20 de ancho.  
  
 
 

o Lo primero que se debe de tomar en cuenta para poder generar un Arreglo 
Rectangular es que objetos se usaran para el arreglo. 

 
o Después el número de filas y columnas que necesitamos para formar nuestra matriz. 

 
 
 
 
 
 
 
 
 
 

o Y Finalmente la distancia necesaria entre Filas y Columnas que componen el Arreglo 
(Para esta distancia tomar la línea de centro de un objeto, a la línea de centro del 
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otro objeto) o bien podemos tomar un punto de referencia del objeto original con 
respecto de los objetos que formen el arreglo. 
 

Debemos de tomar en cuenta que, si tomamos un punto de referencia para la separación 
de filas y columnas, esta distancia se considera Total. Ya que incluye la medida del objeto 
más la distancia de separación.  Esto es, si el objeto mide 20 unidades y queremos tener 
10 unidades de separación entre objetos (como se muestra en la Fig. anterior), la longitud 
a considerar serán 30 Unidades. 
 
Como activar el comando: 
 

• Ejecutar el comando. 
 

• En la línea de comando aparece: -Seleccionar Objetos: 
 

 
 

• Hacer clic sobre el objeto origen y damos Enter. 
 

• En la línea de comando aparece: - Seleccione el grip para editar la matriz o 
[Asociativo/Punto Base/Conteo/Espacio/Columnas/Filas/Niveles/Salida] <salida>. 

 

 
 

• También en la pestaña contextual Array puede especificar la cantidad de filas 
(Rows) y columnas (Columns) que tendrá el arreglo.  

 

 
 
 

• En las casillas Between tanto del panel Columns y Rows se debe especificar la 
distancia entre los elementos. Para especificar la distancia, debe tomar como 
referencia el punto base sobre el objeto origen. 
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Por ejemplo, en la figura: 
 

• En los rectángulos del lado izquierdo, el punto base es el centro del 
rectángulo, por lo tanto, la distancia del punto base será tomada de centro 
a centro. 
 

• En los rectángulos del lado derecho, el punto base es el extremo inferior 
del rectángulo, por lo tanto, la distancia del punto base será tomada de 
extremo a extremo. 

 
 
 
 
 
 
 
 
 

Los pinzamientos mostrados en los elementos que están en los extremos 
indican cual es el punto base que se está tomando como referencia para 
determinar las distancias del arreglo.   

 

 
 

• En la casilla Total, puede especificar el total de distancia que debe medir el arreglo 
tanto en filas como columnas. Cuando se modifica el valor de esta casilla, por 
defecto el valor que se encuentre en la casilla Between se modificará de acuerdo a 
los cambios realizados en la casilla Total.  
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En caso de que necesite reasignar el punto base del arreglo. En la pestaña contextual Array 
Creation, hagar clic sobre el icono Base point 
 

 
 
Se observan los cambios en la posición de los pinzamientos indicando el nuevo origen del 
arreglo 
 

 
 

Al activar la opción Associate  en la pestaña contextual Array Creation, en el 
momento de creación del arreglo, podrá mantener agrupados los objetos, de tal forma que 
puede modificar el arreglo en cualquier momento, depués de haberlo creado. Es decir, 
puede cambiar la cantidad de filas, columnas, distancia entre objetos etc. 
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Copias Polares (Polar Array) 
Una matriz polar es una colección de objetos alrededor de un punto común dispuestas en 
un círculo (o parte del mismo).  
 
Se dibujan a partir de un punto base de giro, en el sentido de las agujas del reloj o en el 
contrario, según el valor negativo o positivo para los grados cubiertos. Las copias se 
organizan a lo largo de un arco de circunferencia. 
 
 
Como activar el comando: 
 
 

  

1.- Ribbon: Pestaña Home ➤ Panel Modify ➤Array 

Línea de Comando: Array (Ar) 
 
 
Copias Polares (Polar Array) 
 
 

o Ejecutar el comando. 
 

o En la línea de comando aparece: Seleccionar Objetos: 
 

 
 

o Hacer clic sobre el objeto origen y damos Enter. 
 

o En la línea de comando aparece: - Especifique el punto central del Arreglo o [Punto 
Base/Eje de rotación]. 

 

 
 

o Seleccionamos el punto que servirá como centro de rotación o giro para el arreglo. 
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o En la línea de comando aparece: - Seleccione el grip para editar la matriz o 
[Asociativo/Punto Base/Objetos/Angulo Entre/Angulo relleno/Filas/Niveles/Rotar 
Objetos/Salida] <salida>. 

 

 
 

• También en la pestaña contextual Array puede especificar la cantidad Items y filas 
(Rows).  

 

 
 

• En las casillas Between tanto del panel Items y Rows se debe especificar la distancia 
entre los elementos. Para especificar la distancia, debe tomar como referencia el 
punto base sobre el objeto origen. 
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• Si en la casilla Rows ingresa un valor mayor a 1 se agregarán filas nuevas al arreglo. 
En la siguiente figura el arreglo tiene 2 filas. 

 
 
 
 
 
 
 
 
 
 
 

• En la casilla Total, puede especificar el total de distancia que debe medir el arreglo 
en filas. Cuando se modifica el valor de esta casilla, por defecto el valor que se 
encuentre en la casilla Between se modificará de acuerdo a los cambios realizados 
en la casilla Total.  

 

• En caso de que necesite reasignar el punto base del arreglo. En la pestaña 
contextual Array Creation, haga clic sobre el icono Base point 

 

 
 

• Se observan los cambios en la posición de los pinzamientos indicando el nuevo 
origen del arreglo 

 

Al activar la opción  Associate  en la  pestaña contextual Array Creation, en el 
momento de creación del arreglo, podrá mantener agrupados los objetos, de tal forma que 
puede modificar el arreglo en cualquier momento, depués de haberlo creado. Es decir, 
puede cambiar la cantidad de Items, distancia entre objetos, filas etc. 
 
Para el caso de las Propiedades, tenemos la posibilidad de editar la Dirección (Direction) 
del Arreglo (Sentido Horario (CW) o Sentido Antihorario (CCW)) y también si los objetos 
estarán alineados o No, con respecto del centro de rotación (Rotate Items). 
  



83 
 

Modificación del tamaño y la forma de los objetos 
 
Dentro de AutoCAD existen varios métodos para ajustar la longitud, y tamaño de objetos 
en relación con otros objetos, ya sea simétrica o asimétricamente. 
 
Alargamiento de objetos (Stretch) 
 
Este comando permite alargar o acortar objetos, es preciso especificar un punto base de 
estiramiento y, a continuación, un punto de desplazamiento. También se puede utilizar en 
forma múltiple. 
 
Como activar el comando: 
 

    

1.- Ribbon: Pestaña Home ➤ Panel Modify ➤Stretch 

Línea de Comando: Stretch (S) 
 
 
Nota. - Debemos aclarar que por medio de los Grips o Pizamientos, como lo vimos al 
principio, es la forma directa y rápida de lograr un estiramiento (Stretch) de los objetos. 
 

o Ejecutar el comando. 
o En la línea de comando aparece: -Seleccionar objetos: 

 

 
 
 

• Seleccionar parcialmente los objetos que se desean estirar usando el modo de 
selección de ventana cruzada (Crossing). 
 

 
Si los objetos se encuentran totalmente dentro del rectángulo de designación 
(mediante rectángulo azul (Window)), los objetos se desplazan.  

 
Si los objetos se encuentran parcialmente dentro del rectángulo de designación 
(mediante rectángulo verde (Crossing)), los objetos de estiran. 

 
 

o Hacer clic en el botón derecho del ratón o damos Enter. 
o En la línea de comando aparece: -Precise punto base o [Desplazamiento]: 

 



84 
 

 
 
 

o Hacer clic en un punto de referencia (Punto Base), preferiblemente perteneciente al 
objeto. 

o Hacer clic sobre el punto donde se desea desplazar el punto de referencia. 
o El objeto se habrá modificado. 

 
 

 
 
Escala de objetos (Scale) 
 
Permite modificar el tamaño de los objetos seleccionados, de modo uniforme, en las 
direcciones X,Y. 
 
Utilizando este comando se podrá aumentar o reducir el tamaño de un objeto. Podrá atribuir 
una escala especificando un punto base. Un factor de escala superior a 1 amplia el objeto. 
Un factor de escala inferior al valor de 1 lo reduce. 

 
Nota.-  Se debe aclarar que este comando en ningún momento tiene nada que ver con la 
escala de impresión. 
 
Como activar el comando: 

 

1.- Ribbon: Pestaña Home ➤ Panel Modify ➤Scale 

Línea de Comando: Scale (Sc) 
 

o Ejecutar el comando. 
 

o En la línea de comando aparece: -Seleccionar objetos: 
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o Seleccionar los objetos que se desean escalar 
 

o Hacer clic en el botón derecho del ratón o damos Enter. 
 

o En la línea de comando aparece: -Especifique punto base: 
 

 
 

o Hacer clic en el punto de referencia. 
 
Este punto no sufre desplazamiento alguno. 

 
o En la línea de comando aparece: -Precise factor de escala o [Copiar / Referencia] 

 

 
 

o Introducir el valor para el factor de escala: 
 
Valores mayores que 1 aumentan el tamaño, multiplicando el tamaño original por 

dicho  factor. 
  
Valores entre 0 y 1, disminuyen el tamaño. 
 

o Damos Enter, el objeto habrá cambiado su tamaño. 
 

 
En la línea de comando aparece: -Precise factor de escala o [Copiar / Referencia]. 
Recordemos que las opciones que aparecen en los corchetes son más herramientas que 
permite utilizar el comando. 
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Estas herramientas nos sirven para: 
 
 

Opción Descripción 

Copy Permite generar una copia a la escala asignada de los objetos seleccionados, 
manteniendo los objetos origen. 

Reference Permite escalar los objetos seleccionados introduciendo una longitud de 
referencia y la nueva longitud que debe pasar a medir. 

Alineación de Objetos (Align). 
 
Con el comando ALIGN se pueden alinear objetos por medio de ejes, cada eje se define 
por medio de dos puntos.  Siempre se selecciona el objeto a alinear. 
 
Como activar el comando: 
 

   Align 
 

Ribbon: Pestaña Home ➤ Panel Modify ➤Align 

Línea de Comando: Align (Al) 
 
 

o Ejecutar el comando. 
 

o En la línea de comando aparece: -Seleccionar objetos: 
 

 
 

o Seleccionar los objetos que se desean Alinear 
 

o Hacer clic en el botón derecho del ratón o damos Enter. 
 

o En la línea de comando aparece: Especifique primer punto origen: 
 

 
 

o Seleccionar el Primer punto Origen 
 

o En la línea de comando aparece: -Especifique primer punto destino: 
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o Seleccionar el Primer Punto Destino. 
 

o En la línea de comando aparece: -Especifique segundo punto origen: 

 
 

o Seleccionar el Segundo Punto Origen. 
o En la línea de comando aparece: -Especifique primer segundo destino: 

 

 
 

o Seleccionar el Segundo Punto Destino. 
o Cuando la línea de Comando pregunte por el tercer punto, damos Enter. 

 

 
 

o En la línea de comando aparece: -Escalar los objetos basados en los puntos de 
alineación: 
 
Es importante señalar que el comando de Alinear también permite escalar los 
objetos, la diferencia es que ese factor de escala está basado en los puntos de 
alineación 
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o Seleccionar Si (Yes) o No (No) y damos Enter. 
 

 
 

Ejercicios Propuestos. 
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Capítulo 5 – Propiedades y trabajo con capas 
 

Organización de un Dibujo. 

 
Es posible organizar los objetos incluidos en los dibujos y controlar la forma en que se 
visualizan y se imprimen, modificando sus propiedades (como las capas, los tipos de línea, 
los colores, el grosor de línea y el estilo de trazado). 
 
Las capas son superposiciones transparentes en las cuales se organizan y se agrupan 
distintos tipos de datos del dibujo. Los objetos que se crean tienen propiedades comunes 
como, por ejemplo, colores, tipos de línea y grosores de línea. Un objeto puede recibir estas 
propiedades de la capa en la que se dibuja, o bien tenerlas asignadas de forma específica. 
El color contribuye a diferenciar elementos similares en los dibujos, mientras que los tipos 
de línea sirven para distinguir fácilmente los distintos elementos de dibujo. Los grosores de 
línea representan el tamaño o tipo de un objeto por su grosor, lo que mejora la calidad del 
dibujo y su legibilidad.  
 
La organización de las capas y de los objetos facilita la gestión de la información de los 
dibujos. 
 

 
 

Objetivos 
 
Al terminar este capítulo, estará en capacidad de: 
 

• Usar las Capas para organizar los objetos en su dibujo. 

• Usar el comando de propiedades principales para copiar las propiedades de un 

objeto a otros. 

• Usar la paleta de propiedades para modificar las propiedades de los objetos. 

• Usar los Tipos de Líneas para distinguir los objetos en el dibujo. 

• Usar sombreados para lograr una mejor visualización del proyecto. 
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Propiedades de los Objetos. 
 
Una parte muy importante de todos los objetos que se dibujan dentro de AutoCAD son las 
propiedades. Dichas propiedades no importando del objeto que se trate siempre estarán 
divididas en dos grupos principales. 
 

• Propiedades Generales 

• Propiedades Geométricas 
 
Las propiedades permiten modificar en el objeto, posición, longitud, color, tipo de línea, 
calidades de línea (Grosor y tipo) y algunas otras características importantes para una 
buena organización de Proyecto. 
 

Propiedades (Properties) 
 
La paleta Propiedades (Properties) permite modificar las Propiedades Generales de los 
Objetos. Estas propiedades a diferencia de las Propiedades Geométricas, son las que 
permanecen cuando se selecciona más de un objeto. Además, estas propiedades permiten 
una administración de proyecto, así como agrupar objetos en base a dichas propiedades 
(Layers). 
 
Para ingresar a la paleta de propiedades, existen varias formas. La más rápida y sencilla 
es seleccionar el objeto del cual se quieren conocer sus propiedades y dar click con el botón 
derecho del mouse; esto abrirá un menú de herramientas y seleccionaremos la opción 
“Properties” (Propiedades), inmediatamente aparecerá la paleta de herramientas 
Propiedades. 
 

                  
 
 
La paleta de propiedades brinda información muy importante del objeto. Esta información 
puede ser la longitud, los grados, área, perímetro, coordenadas de inicio y fin, etc. 
Dependiendo del objeto que este seleccionado. Además, desde esta paleta podemos 
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modificar algunas de esas propiedades. Las celdas que aparecen en blanco son variables 
que puede modificar por el usuario, las que aparecen en gris, son variables del sistema y 
solo son de carácter informativo, que no permiten ninguna modificación. 
 
 Para el caso de las Propiedades Generales, los principales parámetros de modificación 
son tres: 

  
1. Color 
2. Tipo de Línea (Linetype) 
3. Grosor de Línea (Lineweight) 
 
 
 
 
 
 
 
 
 

Además de la paleta de Propiedades (Properties), las Propiedades Generales de los 
objetos, también las podemos encontrar en el Ribbon, la ruta correcta para esta herramienta 
es: 
 
 

Ribbon: Pestaña Home ➤ Panel Properties 

Línea de Comando: Properties (Pr) 
 
 
 
 
Ya sea por la paleta o por el panel de herramientas, al cambiar cualquiera de estas 
propiedades el objeto se verá afectado, y la misma información se reflejará en ambos lados, 
ya que al tratarse de la misma herramienta (Propiedades) estas tienen relación una con otra 
al 100%. 
 
El camino más rápido de conocer las Propiedades Generales del Objeto, será 
seleccionando dicho objeto y echando un vistazo al Panel de Propiedades en el Ribbon. 
 
Color 
 

Permite cambiar los colores y tonos de los objetos para una mejor organización del 
proyecto. Ya sea por el Panel o la Paleta de Herramientas, al seleccionar la Opción de 
Color se mostrará una lista con los colores primarios, que además son los de uso 
común según las normas de dibujo. 
 
Si se requiere trabajar con otro tipo de colores a los clásicos, AutoCAD cuenta con 
Índices y librerías, que permiten una gran variedad para su uso, además de que dentro 
de estas opciones se puede Trabajar con los Famosos Pantones. 
Para ingresar a dichas librerías, solo basta hacer click en la opción “Select Color…” 
que aparece al final de la lista de colores en ambas herramientas. 
 

1 

2 

3 

1 

3 

2 



93 
 

 

 
 
 

Al hacer click en la opción “Select Color…” automáticamente aparecerá la 
herramienta de selección de color, dicha herramienta está compuesta por tres 
pestañas: 

 

Index Color (Índice de Color).-  

 
Permite seleccionar los colores en base a un número asignado de forma automática 
por el programa, además dichas tonalidades están basados en el sistema de selección 
RGB que es la cantidad de tonos de Rojo (Red), Verde (Green) y Azul (Blue) (RGB)  

 

 
  

True Color (Color Exacto o Real).-  

 
Permite seleccionar los colores en base a dos Modelos de Color de uso común en el 
diseño. 
 
Los dos modelos de tonalidades están basados en el sistema de selección RGB que 
es la cantidad de tonos de Rojo (Red), Verde (Green) y Azul (Blue) (RGB).  
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Con la diferencia de que el primero calcula dichas tonalidades por medio de la Dureza 
(HUE), Saturación (SATURATION) y Luminiscencia (Cantidad de Luz) dando como 
resultado el modo HSL. 
 
El segundo modelo está basado en el sistema de selección RGB que es la cantidad de 
tonos de Rojo (Red), Verde (Green) y Azul (Blue) dando como resultado el modo (RGB)  

      
 

Color Books (Librerías de Color).-  

 
Permite seleccionar los colores en base a librerías y catálogos estandarizados.  
 
Dentro de esta opción es que están disponibles los PANTONE. En la actualidad la 
mayoría de los plotters o impresoras profesionales, cuentan con estas librerías 
precargadas, para lograr un realismo en la impresión de los diseños, y que la variación 
entre lo que se ve en la pantalla y el papel sea casi nula.  
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Una vez que se ha seleccionado el color deseado, damos OK para aceptar el cuadro. 
 
Nota.- Es importante comentar que cada que se desea asignar un color a los objetos, 
se tiene que hacer este mismo proceso a menos que se configure un LAYER (Capa) 
para agrupar más de un objeto con las mismas Propiedades. 
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Tipo de Línea (Linetype) 
 
Permite modificar el Estilo de Línea de los objetos seleccionados, esta acción puede servir 
para diferenciar líneas ocultas, de líneas de contorno, si se trata de líneas de flujo, de 
centros de frontera, de colindancia, para definir alguna vista de corte, etc. 
Para ingresar a las librerías de tipo de línea, solo basta hacer click en la opción “Other” 
que aparece al final de la lista de colores en el Panel de herramientas. Esta opción no está 
disponible desde la paleta de herramientas.  

 

 
 
 

Al hacer click en la opción “Other” automáticamente aparecerá la herramienta de 
selección de tipos de línea.  
Es importante comentar que la librería de tipo de línea que se carga es la 
correspondiente al tipo de plantilla de trabajo que estemos utilizando como base para 
nuestro proyecto. Sobre todo, por la Proporción de Tamaño y Escala de los tipos de 
línea.  
 
Con base a la Plantilla ACADISO.DWT, ésta mostrara la librería ACADISO.LIN, y la 
plantilla ACAD.DWT, mostrara la librería ACAD.LIN 
 

 
 

 
El asistente muestra únicamente los tres tipos de líneas predefinidos por AutoCAD. 
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Para Cargar los tipos de línea es necesario dar un click sobre el botón Cargar (Load) 
del Administrador de Tipos de Línea (Linetype Manager) 
Aparecerá la librería correspondiente al tipo de plantilla de trabajo utilizado, y lo único 
que hay que hacer es seleccionar el tipo de línea deseado y dar OK, para aceptar el 
cuadro de Cargar o Descargar Líneas (Load or Reload Linetypes). 

 
Se pueden seleccionar varios tipos de línea al mismo tiempo con el fin de hacer una 
carga múltiple. 

 

 
 

Una vez terminada la carga de los tipos de línea, dentro del administrador aparecerán 
los tipos de línea cargados en forma de lista y con su vista previa. Además, desde este 
Administrador de Tipos de Línea es posible asignarles una Escala Global a las líneas 
cargadas.  
 
La Escala Global permite que TODOS los tipos de línea utilizados se inserten con un 
valor Mayor o Menor al predefinido por AutoCAD que es de 1. Este valor de 1 está 
pensado en referencia de 1m en AutoCAD.  1 m = 1000 mm. 
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Para visualizar las opciones de la Escala Global (Global Scale) y la Escala del Objeto 
Actual (Current Object Scale), solo tendremos que dar click en el botón de Mostrar u 
Ocultar Detalles  (Show o Hide Details). 
 
 

 
 

 

 
 
 
 

Nota.- Es importante señalar que desde la Paleta de Propiedades es posible editar la 
Escala de Tipo de Línea (Linetype Scale) exclusivamente para el o los objetos 
seleccionados. 

 
Si por alguna razón mientras no esté asignado a ningún objeto o se encuentre en uso, se 
requiere borrar una línea cargada, lo único que tenemos que hacer es dar click en el botón 
Borrar (Delete). 
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Una vez que el proceso de carga de los tipos de línea ha concluido, lo único que tendremos 
que hacer es aceptar el cuadro del Administrador de Tipos de Línea dando click en el botón 
OK. 
 

 
 

Para asignar los tipos de línea cargados a los objetos seleccionados, solo basta hacer 
click en la opción de cualquiera de las herramientas, ya sea del Panel o de la Paleta de 
Propiedades donde aparecerá la lista con los tipos de línea. 
 

 
 

Nota.- Es importante comentar que cada que se desea asignar un tipo de línea a los 
objetos, se tiene que hacer este último proceso a menos que se configure un LAYER 
(Capa) para agrupar más de un objeto con las mismas Propiedades. 
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Grosor de Línea (Lineweight) 
 
Permite modificar los espesores de las líneas que forman los objetos dentro de un proyecto. 
A esta opción también se le conoce como Calidades de Línea.  
 
Ya sea por el Panel o por la Paleta de Herramientas, tenemos la posibilidad de escoger el 
grosor o calidad que se desea asignar. Es importante señalar que el valor Predefinido 
(Default) de AutoCAD para la calidad de la línea es de 0.25 mm. Para una plantilla 
ACADISO y 0.010” para una plantilla ACAD. 

 
Ya sea por el Panel o por la Paleta de Herramientas, tenemos la posibilidad de escoger el 
grosor o calidad que se desea asignar al objeto seleccionado. 
 

    
 

Para poder ingresar a la Herramienta de Configuración del Grosor de Línea (Lineweight 
Settings) tenemos que dar click sobre la opción Lineweight Settings… que aparece al final 
de la lista de las calidades de línea. Esta opción no está disponible desde la paleta de 
herramientas.  
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Automáticamente se muestra el cuadro de Configuración del Grosor de Línea (Lineweight 
Settings. 

 
En esta herramienta podemos cambiar la calidad de línea predefinida, seleccionar el tipo 
de unidades en el que se puede trabajar (mm, in), así como la calidad de visualización en 
la pantalla para los grosores asignados. 
 

 
 

 
 
 
 



102 
 

Nota.- Es importante comentar que cada que se desea asignar la calidad de línea a los 
objetos, se tiene que hacer este proceso a menos que se configure un LAYER (Capa) 
para agrupar más de un objeto con las mismas Propiedades. 

 

 
 
El resultado final de la Herramienta Propiedades permitirá conocer los conceptos básicos 
para una buena organización de proyecto. 
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Capas (Layers) 
 
"Capas" (Layers) es un concepto que permite agrupar la geometría dibujada en distintas 
categorías de acuerdo con características similares o de un tema común. Esto permitirá 
ejercer control sobre el dibujo, aplicando las propiedades de las capas. Por ejemplo: como 
la asignación de colores y tipos de línea.  
 
Las Capas se pueden manipular de forma individual, además de tener la posibilidad de ser 
visibles o invisibles, así como de poderse bloquear para evitar su edición.  
 
Se pueden visualizar las capas como hojas de transparencias de un libro de Anatomía. Con 
cada hoja conteniendo una distinta categoría de datos (Esqueleto, Músculos, Sistema 
Circulatorio, Sistema Respiratorio, etc.), pero cuando se ve todo el conjunto se muestra el 
cuadro completo de una persona.  
 
Del mismo modo, en AutoCAD, puede haber cualquier número de capas, todos ellos con 
sus respectivos datos y la combinación de ellos en el diseño completo. 
 
 

 
 
Los objetos creados tienen propiedades comunes que incluyen color, tipos de línea y 
espesor o calidad de línea. Estas tres propiedades son comunes a cualquier objeto 
dibujado. Un objeto puede heredar estas propiedades desde el layer en el cual es dibujado, 
o estas propiedades pueden ser asignadas específicamente a los objetos individualmente 
como ya hemos visto.  
 
Los colores ayudan a distinguir elementos similares en el dibujo, mientras que los tipos de 
línea ayudan a diferenciar fácilmente entre distintos elementos gráficos, tales como líneas 
de eje o aristas ocultas.   
Los espesores representan el tamaño o tipo de espesor de un objeto, mejorando el dibujo 
e incrementando la legibilidad. Organizar los layers y los objetos en layers hace más sencillo 
controlar la información en el dibujo o proyecto.  
 
Cuando se dibuja, siempre se hace sobre algún layer. Puede ser el layer por defecto o 
alguno creado específicamente.  Cada layer tiene asociado su propio color, tipo de línea y 
espesor. Se pueden usar los layers para organizar el dibujo en grupos de objetos como una 
forma de identificar diferentes objetos con variedad de colores, tipos de líneas y espesores.  
 



104 
 

Por ejemplo, se puede crear un layer parar las líneas de ejes y luego asignar las 
propiedades deseadas para todas las líneas de ejes (color, tipo de línea y espesor) al layer. 
Cuando se dibuja una línea de eje, primero se pone activo el layer de las líneas de eje y 
luego se comienza a dibujar, por lo que no se necesita especificar color, tipo de línea y 
espesor para cada línea de eje dibujada.  
 
Cuando se utiliza constantemente un mismo esquema de Layers (Capas), se puede armar 
una Plantilla (Template) con Layers y sus Tipos de Líneas, Colores, Espesores y Estilos de 
Ploteo (Estilos de Impresión) correspondientes.   
 
Nota.- Es importante señalar que cuando se inicia un dibujo AutoCAD tiene predefinida la 
Capa “0” (cero). 
 
Esta capa tiene asignado el Color numero 7 (blanco o negro dependiendo del color de fondo 
de la pantalla), el Tipo de Línea Continuous, y el espesor en DEFAULT, o sea por defecto 
(el valor puesto por defecto es un espesor de 0.01 in o 0.25 mm). El Layer “0” por ser la 
Capa de Trabajo predefinida de AutoCAD no puede ser borrado o renombrado.  
 
La forma correcta para ingresar al Administrador de Capas (Layer Properties Manager) es 
por medio del Ribbon. En la pestaña de Home, encontramos el Panel de Layers.  El primer 
icono ubicado en la esquina superior  Izquierda que es conocido como “Layer Properties”. 
 

  
 
 

Otra forma de encontrar dicha herramienta, es escribiendo en la línea de comando 
directamente la palabra “Layer” o bien escribiendo su modo abreviado o entrada corta para 
el teclado “LA” y dando Enter para aceptar el comando. 
 
Por cualquiera de estos dos caminos, automáticamente se mostrara el Administrador de 
Layers (Capas)  “Layer Properties Manager”. 
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El administrador de Layers es la herramienta que permitirá crear, editar y borrar Layers.  
 
Es importante señalar que una vez creado un Layer se puede modificar al 100%, pero 
demos tomar en cuenta que si el Layer ya está en uso, este no podrá ser BORRADO por 
medio de esta herramienta. 
 
Crear un Layer  
 
Una vez que el administrador de layers está activo para crear una capa nueva tenemos: 
                                                                                                                     

• Hacer click sobre el icono “New Layer” de este cuadro de trabajo 
 

 
 
 Ingresar el nombre del nuevo layer en el casillero y damos Enter.  
 

 
 

Nota.- La configuración de las propiedades (Color, Tipo de Línea y Grosor) es por medio 
de las herramientas ya conocidas, pues tenemos que recordar que los Layers se agrupan 
en base a estas propiedades. 
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• Para asignarle un color, damos click sobre el cuadro que muestre el color en la 
columna del mismo nombre. El color se asigna atreves de las paletas y libros de 
colores que ya conocemos. 

 

 
 

 
 

• Para asignarle un tipo de línea, damos click sobre la palabra “Continuous” de la 
columna Linetype (Tipo de Línea). 

 

 
 

 
 
 
 

• Para asignarle calidad de línea, damos click sobre la palabra “Default” de la columna 
Lineweight (Grosor de Línea). 
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Una vez que se han creado los Layers con la configuración de sus propiedades, el 
administrador de capas permitirá editarlos de la misma manera que fueron creados.   
 
Para cerrar el administrador de capas, solo daremos click sobre el tache que se encuentra 
en la barra de identificación. 
 

 
 
Ahora podemos comprobar ya sea por la Paleta de Herramientas de Propiedades o bien 
por el Panel de Layers en el Ribbon, que nuestros layers están listos para usarse. 
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Activar un Layer   
 
Para activar o usar los Layers creados se puede hacer de dos formas.  
 

o Cuando los Objetos ya han sido creados, tenemos que seleccionar los objetos e ir 
al Panel de Layers para seleccionar la capa en la cual lo queremos agrupar. Así el 
objeto formará parte del Layer al que fue asignado.  

 

 
 
Colocar una capa como actual 
 
Se coloca como la capa de Trabajo o Actual (Current Layer), seleccionando el nombre del 
layer que se desea usar, una vez activo todo lo que se dibuje a partir de este cambio formara 
parte del layer de trabajo. 
 
Para conocer la capa a la que pertenecen los objetos, una alternativa es seleccionando el 
objeto y de inmediato en el panel de layers aparecerá la capa a la que pertenece, sin 
necesidad de ingresar al Cuadro de Propiedades aun cuando el layer que se encuentre 
como activo sea diferente. 
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Cuando un objeto que fue creado con anterioridad y tiene asignadas propiedades 
específicas al ser asignado a un Layer este no cambia sus propiedades por las de la capa 
a la que ahora pertenece, esto es porque AutoCAD respeta las propiedades particulares 
asignadas a cualquier objeto dándoles prioridad sobre cualquier otra herramienta que 
proporciona propiedades en grupo. 
 

 
 
Para cambiar esas propiedades particulares por las de la capa a la que pertenece el objeto, 
tenemos que ir al Panel de Propiedades y verificar que dichas propiedades (Color, Tipo de 
Línea, Grosor) estén configuradas en la opción “ByLayer” (Por Capa). 
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La organización del proyecto mediante los Layers, no termina con la posibilidad de agrupar 
objetos en base a sus Propiedades Generales (Color, Calidad y Tipo de Línea). Cuando 
hablamos de Organización de Proyecto dentro de AutoCAD inmediatamente debemos 
pensar en la posibilidad que brinda el programa de visualizar y bloquear los objetos con la 
finalidad de poder convertir un proyecto standard en un proyecto más dinámico y con mejor 
organización. 
 
En el panel de Layers podemos visualizar una iconografía previa al nombre de cada una de 
las capas. Esta iconografía permitirá lograr dicha organización en los proyectos. 
 

 
 

Estos 3 o 4 iconos, dependiendo del espacio de trabajo que se trate (Espacio de Modelo o 
Espacio de Papel (Layout)), permitirán totalmente la organización del Proyecto. 

 

 
 
 
 

 
 
 
 

 

Vista del Panel de Layer desde el Espacio de Modelo 
(Model Space) 

Vista del Panel de Layer desde el Espacio de Papel  (Paper 
Space) 
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Por ahora solo enfocarse a trabajar en las opciones mostradas dentro del Espacio de 
Modelo (Model Space). Y en su momento las revisaremos dentro del Espacio de Papel 
(Layout)  
 
Encendido/ Apagado (ON/OFF) de capas 
 
Cuando en el panel de layers se muestra el Foco de alguna de las capas apagado (OFF), 
los elementos de la capa no serán visibles (Fig. 2). Para encender o apagar una capa solo 
basta dar click sobre el icono del Foco. 
 
Nota.- La opción de apagar el foco de una capa también origina que los objetos contenidos 
en ella no sean tomados en cuenta para Impresión. 
 
La figura 1, muestra la Capa (Layer) líneas ocultas, que es la que controla las líneas ocultas 
de la pieza de al lado. 
 

 
 
 
 

 
 

Figura 1 – Capa líneas ocultas Encendida (ON) 

Figura 2 – Capa 2-HID Apagada (OFF) 
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Cuando un layer se encuentra como el Layer Actual o de Trabajo y se apaga el Layer, 
AutoCAD mandará un aviso indicando que el Layer de Trabajo será apagado. Cuando un 
layer se apaga, sigue siendo editable. 
 

 
 
Nota.- No se recomienda Apagar el Layer  de Trabajo, ya que si por alguna razón dibujamos 
algo mientras el estado del Layer está apagado dará el efecto de que los objetos 
desaparecen, pero al encender la capa los objetos dibujados se mostraran. 
 
Lo recomendable será regularmente poner como Layer de Trabajo cualquier otra Capa que 
no sea la que queremos apagar. 
 
Descongelado/ Congelado (Thaw/Freeze) de capas 
 
Cuando en el panel de layers se muestra el icono de Sol en alguna de las capas (Freeze), 
los elementos de la capa no serán visibles, ni serán tomados en cuenta para impresión. Los 
elementos de una capa congelada no están disponibles para edición. 
 
Pero la diferencia entre estos dos (Foco y Sol) es que el Sol Apagado descarga los Objetos 
de la Memoria del Programa para hacer más ligero el trabajo dentro de AutoCAD cuando 
se trata de Grandes Proyectos. 
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Es importante señalar que cuando un layer se encuentra como el Layer Actual o de Trabajo 
y se quiere apagar el sol de ese Layer, AutoCAD mandara un aviso negando la posibilidad 
de congelar el Layer de Trabajo. 
 

Lo recomendable será poner como Layer de 
Trabajo cualquier otra Capa que no sea la que 
queremos Congelar. 
 
 
 
 
 
 

 

Bloqueo / Desbloqueo (Lock/Unlock) de capas 
 
Cuando en el panel de layers se muestra el candado de alguna de las capas cerrado (Lock), 
los elementos de la capa serán bloqueados con el fin de no ser modificados por accidente 
al momento de editar cualquiera de las capas que lo rodean. 
 
Cuando una capa es Bloqueada, no tenemos oportunidad alguna de modificar los objetos 
contenidos en ella, mucho menos de borrarlos. Además, al acercarnos con el puntero a una 
capa bloqueada es posible visualizar en el puntero un pequeño candado que indica el 
bloqueo que tiene dicha capa, además de un ligero desvanecimiento en la tonalidad de la 
capa bloqueada. 
 
Al abrir el candado la capa podrá volver a ser editada al 100%. 
 

 
 

La Importancia de las capas radica en la posibilidad de tener todas las partes que forman 
un proyecto en un solo archivo y que al requerir información específica, lo único que 
tengamos que hacer es encender o apagar las vistas necesarias para poder visualizar 
solamente las capas requeridas. 
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Es importante señalar que todos los Objetos dibujados en AutoCAD sin excepción, pueden 
ir contenidos en capas (Textos, Tablas, Cotas, Imágenes, Trazos, etc.) 
 

Opciones de cambio de estado de capas 
 
Usando las opciones de panel Layers puede cambiar el estado de una capa más rápido. 
Así: 
 
Para cambiar el estado de una capa seleccionando un objeto en la pantalla: 
 

1. Seleccionar un objeto y escoger los iconos indicados según lo que se requiera 
hacer 

 

 
     1       2         3        4      5 
 
1 - Apaga capa a la cual el objeto (s) pertenece 
2 - Todas las capas se desactivan excepto las capas de los objetos seleccionados  
3 - Congela la capa 
4 - Bloquea la capa a la cual el objeto (s) pertenece 
5 - Para cambiar la capa actual, puede seleccionar un objeto en esa capa 

 
 

 
  1         2         3         4       5 
 
1 - Se activan todas las capas que se habían desactivado anteriormente 
2 - Anula los efectos del comando AISLARCAPA anterior 
3 - Se descongelan todas las capas que se habían congelado anteriormente 
4 - Se desbloquean todas las capas que se habían bloqueado anteriormente 
5 - Puede cambiar la capa mediante la selección de un objeto en la capa de         

destino 
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Patrones de sombreado (Hatch) 
 
Existen varios métodos para añadir patrones de sombreado a los dibujos. El comando 
HATCH proporciona la mayoría de las opciones de sombreado. 
 
Estos no son meramente decorativos; sino que cumplen una importante función al indicar 
los tipos de materiales, suelo, revestimientos, y las secciones transversales.  
 
Un sombreado se crea designando el objeto que se va a sombrear o rellenar, o definiendo 
un contorno y precisando posteriormente un punto interno.  
 
Para crear un patrón de sombreado 
 

  Hatch 
 

Ribbon: Pestaña Home ➤ Panel Draw ➤ Hatch 

Línea de Comando: Hatch (H) 
 

o Ejecutar el comando. 
 

o En la línea de comando aparece: -Seleccionar punto interno 
[Seleccionar Objetos/Configuración] 
 

 
 

 
 
 
 
 
 
 
 
 
 

Nota.- Tomar en cuenta que esta acción se va a realizar en elementos cerrados, por esa 
razón el programa pide seleccionar un Punto Interno 
 
1. Dar click dentro del área que se desea sombrear. 

 
2. El sombreado se dibujará en el área designada 

 
3. En la pestaña Hatch Creation en el panel Pattern seleccionar el patrón de relleno que 

requiere aplicar. 
 



116 
 

 
 
 

4. Además, la pestaña Hatch Creatión tiene todas las opciones para la Edición del 
Hatch o Sombreado. 

 
Panel de Propiedades  
 

1. Tipo de Sombreado. - Permite seleccionar el estilo de sombreado que 
deseamos utilizar, ya sea de tipo Sólido (Solid), Gradiente (Gradient) o bien un 
Arreglo (Pattern).  

 
2. Color. - Permite escoger el color que tendrá el Arreglo. Para el Caso del 

Gradiente (Gradient) el degradado puede ser a dos colores. Para el Arreglo 
(Pattern), es posible escoger 2 colores, uno para la Trama y otro como Fondo. 

 
3. Escala. - Permite Asignarle el tamaño de visualización que tendrá el 

Sombreado. El valor que presentan por defecto TODOS los sombreados es de 
1, y si queremos que se mas Grande, usaremos valores mayores a 1, si 
queremos que el sombreado sea más Pequeño, usaremos valores menores a 1. 

 
4. Ángulo. - Permite asignarle un ángulo de inclinación a cualquier tipo de 

sombreado. 
 
5. Transparencia. - Permite asignarle un desvanecimiento a cualquier tipo de 

sombreado. Esta transparencia va de 0 a 90 en valores de %. Para que la 
Transparencia se pueda visualizar una vez aplicada, es necesario encender 
en la barra de estado la herramienta “TPY”. 
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Panel Pattern 
 
En la sección de Arreglo (Pattern), tenemos la posibilidad de escoger el tipo de sombreado 
o de gradiente a utilizar. 
 

 
 
 
 

 
 

 
Pieza con sombreados Aplicados. 

 

Hatch Gradient 
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Opciones de panel 
 

1. Asociatividad.- Si tendrá relación o no con respecto del área en la que fue aplicado. 
Es decir si el sombreado es Asociativo, y la figura es modificada en su forma original, 
el sombreado tendrá la propiedad de acomodarse a la nueva forma del área 
asignada. 
 

2. Sombreados Separados.- Permite al colocar uno o varios sombreados, si estos 
serán dependientes entre sí o no. 

 
3. Detección de Islas.- Es la forma en que el sombreado se relacionara con respecto 

del área en la que es asignado dependiendo de la posición de los objetos internos. 
Se le conoce como ISLAS a todos los objetos que se encuentran contenidos dentro de otros 
objetos, siempre y cuando estos formen un área cerrada. 
 

 
Normal: Comienza sombreando el contorno más exterior, desactiva el sombreado 

para el siguiente contorno y se vuelve a activar si detecta otro contorno más 
interior. 

 
Exterior: Sombrea únicamente el contorno más exterior, desactivando el 

sombreado para todos contornos interiores. 
 
Ignorar: Sombrea considerando únicamente el contorno más exterior e ignorando 

todos los contornos interiores. 
 
 

4. Propiedades Principales.- Permite copiar las propiedades y configuración de un 
sombreado hecho con anterioridad. 
 

 
 
 
 
 
 

 1 

 4 

 2 

 3 

 3 
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 Nota.-  
 Tanto el Gradiente (Gradient) como el Sombreado (Hatch) se Activan con diferente 
comando, pero como pudimos darnos cuenta, comparten la misma herramienta para poder 
modificar sus propiedades, así como el mismo proceso de aplicación y edición. 
  

 3 



120 
 

Ejercicios Propuestos 
 
Asignarle Propiedades y Capas a cada uno de los ejercicios sig. 
 
Utilizando las siguientes Capas: Contorno, Sombreado y Ejes. 
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Capítulo 6 – Textos, tablas y bloques 
 

Organización de un Dibujo. 
La capacidad de manipular electrónicamente, organizar y obtener información de un dibujo 
supera todo lo que podría llevar a cabo utilizando métodos manuales. Sin embargo, para 
sacar provecho de esta ventaja, usted debe ser competente en el uso de los comandos y 
los métodos que hacen que el software se mucho más viable que el lápiz y el papel. 
 
Aprenderá cómo implementar las mejores formas para rotular, poner observaciones, crear 
tablas de materiales, costos, así como el poder generar librerías de su simbología o formas 
de uso más común. 
 
 

 
 
 
Objetivos 
 
Al terminar este capítulo, estará en capacidad de: 
 

• Crear Textos y Tablas Dinámicos 

• Conocer la aplicación y edición de los Textos y Tablas 

• Crear Bloques 

• Conocer la aplicación y edición de Bloques 
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Textos y notas 
 
Una parte importante dentro de los proyectos es poder utilizar textos, con la finalidad de 
dejar alguna nota, etiqueta, referencia, observaciones, listas de materiales, etc. que son 
indispensables dentro de cualquier proyecto. 
 
AutoCAD a partir de la versión 2006 trabaja con dos tipos de textos, estos tipos son: 
 

• Multilínea de Texto (Mtext) 

• Texto en línea unica (Text) 
 
Es importante aclarar que hasta antes de la versión 2006, el Texto en línea única era la 
forma anterior de colocar textos en AutoCAD. A la multilínea de texto se le conoce también 
como Texto Dinámico. 
 
 
Multilínea de Texto (Mtext) 
 
Los Textos Dinámicos permiten poner párrafos de texto dentro del proyecto, además la 
forma de edición en sus propiedades y en la escritura son muy semejantes a cualquier 
Editor de Texto de uso común. Por su forma dinámica y la facilidad con que se aplican y 
editan, los textos dinámicos actualmente son los de mayor uso dentro de AutoCAD. 
 
Para el caso del texto dinámico, tenemos un panel exclusivo para el uso de esta 
herramienta. 
 

 
 
Como activar el comando: 
 

    
Mtext 
 

Ribbon: Pestaña Home ➤ Panel Annotation ➤Mtext 

Ribbon: Pestaña Annotate ➤ Panel Text ➤Mtext 

Línea de Comando: Mtext (Mt) 
 

 
o Ejecutar el comando. 

 
o En la línea de comando aparece: -Definir primera esquina: 
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o Damos la primera esquina. 
 

Al definir la primera esquina y arrastrar el puntero se mostrara un rectángulo como 
se muestra en la figura, además es importante tomar en cuenta que en el puntero 
aparece el valor de la coordenada del cuadro (244.4865 < 329°), esto dará la 
referencia del tamaño del cuadro de texto. 

 

 
 
El tamaño del texto usado por este comando por defecto es de 2.5 mm. Mientras se 
está colocando el cuadro de texto, una buena referencia para identificar que el 
tamaño del cuadro es proporcional al tamaño de texto, es que aparecerán las letras 
abc. Para esto, puede usar Zoom en tiempo real para ir modificando la escala de 
zoom de la vista, al mismo tiempo que arrastra el puntero para definir el tamaño del 
cuadro de texto. 

 
 

o En la línea de comando aparece: -Definir esquina opuesta: 
 

 
 

o Damos click para fijar el cuadro de texto. 
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En ese momento podemos iniciar la escritura dentro del Cuadro de Texto, y se activara 
inmediatamente en el Ribbon, la pestaña Editar Texto (Text Editor). 
 
 

 
 
 
La pestaña Editar Texto (Text Editor) ofrece una serie de herramientas de edición y 
propiedades de texto, como si se tratara de un editor de textos pero dentro de AutoCAD. 
 
 
Nota.-  Si por alguna razón se llega a salir de la herramienta de edición de texto, para volver 
a regresar a editar el texto, es dándo doble click al Multitexto que se desea editar. Además, 
es posible seleccionar y copiar un Texto desde cualquier editor de textos de uso común, o 
bien desde internet para ser editado al 100% en AutoCAD. 
 
 
A continuación, revisaremos cada uno de los paneles que forman la Barra de Edición de 
Texto. 
 
Panel de Estilo (Style) 
 
Como primera opción encontramos (De Izquierda a Derecha) el Panel de Estilo (Style), en 
donde podremos seleccionar el formato del Texto (Standard aparece como el estilo 
predefinido) y la altura del texto.  
 
A diferencia de otras herramientas para procesar texto, aquí tendremos que escribir el 
tamaño de texto deseado manualmente (2.5 es el tamaño predefinido). 
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Panel de Formato (Formatting) 
 
Despues encontramos el Panel de Formato (Formatting), aquí podremos seleccionar el 
tipo de fuente, los colores, si es en negritas, Itálica, subrayados inferior y superior, así como 
el posible fondo del cuadro de Texto. 
 
Además, al expandir este panel encontramos herramientas para inclinación de la fuente, 
separación entre caracteres, así como la herramienta para ver las letras gordas. 
Herramientas que en los tiempos de dibujo a mano se realizaban con el leroy o plantilla, o 
bien con las regletas de dibujo. 
 
 

 
 

 
En cuanto al estilo de Fuente, la herramienta de Texto Dinámico 
reconoce todos los tipos de fuente que tenga instalados la PC 
en la que se está trabajando, no importa la herramienta o 
programa al que pertenezcan. 
 
La fuente predefinida de la herramienta es la Arial. 
 
 
 
 
 
 
 
 

 
Para el caso de los colores, toma el que tenga asignado la 
Capa (Layer) en la que se está ingresando el Texto. 
Además, esta herramienta permite seleccionar los colores 
de las paletas y librerías de colores que ya hemos visto 
anteriormente. 
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Panel de Parrafo (Paragraph) 
 
después encontramos el Panel de párrafo (Paragraph), esta herramienta permite 
asignarle al texto el tipo de justificación, el espacio entre las líneas de texto, si llevara 
números, sangrías, etc. 

 
 

 
 
En la opción en donde permite asignarle los 
números o viñetas, también es posible asignar 
una secuencia de lista con letras ya sean 
mayúsculas o minúsculas. 
 
Así mismo permite continuar la lista con la que 
se está trabajando, o bien reiniciar nuevamente 
la lista no importando del formato que se trate 
(letras o números). 
 
 
 

 
Ejemplo de Texto con Viñetas 
 
Para el caso del espacio entre líneas o Interlineado, es posible dar una separación 
personalizada, AutoCAD permite como máximo el valor de 2.5. 
 

 
 
Para el caso de la alineación del párrafo de Texto, la herramienta cuenta con 2 opciones. 
 
1 – Permite asignar la alineación de los párrafos de texto, tal cual los conocemos en 
cualquier editor de texto, esta alineación puedes ser: Justificada, Derecha, Izquierda, 
Centrada y Distribuida. 

 1 
 2 
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2 – Permite Justificar todo el cuadro de texto, es decir, lo toma como si fuese una gran celda 
de texto. 
 

 
 
Panel de Insertar (Insert) 
 
Una de las caracteristicas mas importantes del Texto Dinamico, es la posibilidad de ponerlo 
con formato de columnas, ademas de poder insertar con mucha facilidad la simbologia 
necesaria para los textos y numeros en los proyectos. 
 

 
 
Para el caso de poner un texto en columnas, AutoCAD permite hacerlo de 2 formas: 
 

 
 1 - Columnas Dinámicas: En esta opción pueden ser 
de diferente altura o bien todas ellas de igual tamaño, 
pero se aumentan o disminuyen las columnas 
dependiendo del ancho y largo de la columna. 
 
2 - Columnas Estáticas: Todas las columnas serán 
de igual tamaño y distribuido en un numero 
predefinido de ellas. 
 
3 – Configuración de Columna: permite definir los 
para metros predefinidos de largo y ancho de 

columna. 
       
 

 1 
 2 

 3 
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Para el Caso de las columnas dinámicas, las podemos definir con Auto altura o de altura 
manual, en los dos casos, esta opción permitirá a partir de los grips del texto en columnas 
poder ajustar la altura de las columnas. 
 

 
 
 
La siguiente figura muestra el ajuste de las columnas en la forma de Auto altura, en donde 
con solo un grip es posible definir la altura de la columna y que las demás se vean afectadas 
de manera automática. 

 
En esta figura podemos ver el ajuste de las columnas en la forma de altura manual, en 
donde cada columna tendrá un grip de ajuste para definir la altura de la columna. 

 
 
La herramienta de Configuración de Columnas (Column Settings) se puede realizar una 
configuración predefinida en cuanto a la Altura (Height), el Ancho de columna (Width), la 
Separación entre columnas (Gutter), no importando del tipo de columnas a utilizar. 
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La Figura Muestra un Texto en 2 Columnas 
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Para el caso de la Simbología (Symbol), a partir de la 
versión 2006 de AutoCAD puede insertar todos los símbolos 
y nomenclaturas propios de un plano o proyecto, esta 
simbología puede ser: diámetro, grados, igualdad, líneas de 
momentos, fase eléctrica, etc.  

 
 
 
 
 
 
 
 
 
 
 
 

 
Además de todo lo que hemos visto AutoCAD permite 
realizar revisiones ortográficas, buscar y remplazar 
palabras, insertar campos y otras opciones que permiten 
hacer de la Herramienta de Multitexto, la herramienta de uso 
común para notas y rótulos dentro de AutoCAD. 

 
Nota.- Es importante señalar que la Herramienta de Multitexto estará presente en todas las 
herramientas donde AutoCAD solicite poner notas, rótulos y textos.  
La opción de Texto en línea unica, no permite una edición dinámica, como la que acabamos 
de ver. Esto hace que en la actualidad no sea tan utilizada como la herramienta de 
Multitexto. 
 

Tablas Dinámicas (Dynamic Tables) 
 
Dentro de las Tablas Dinámicas tenemos la posibilidad de poner formulas, realizar cálculos, 
así como su edición. Para el caso de las Tablas dinámicas, tenemos un panel exclusivo 
para el uso de esta herramienta. 
 
Como activar el comando: Table 

    

Ribbon: Pestaña Home ➤ Panel Annotation ➤Table 

Ribbon: Pestaña Annotate ➤ Panel Tables ➤Table 

Línea de Comando: Table (Tb) 
 
 

 
Al ejecutar el comando aparecerá en automático el cuadro de configuración de las tablas, 
en el podemos seleccionar el número de filas y columnas, así como el ancho de la columna 
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y el alto de la fila. Además, permite seleccionar cómo se insertará la tabla dentro del 
proyecto. 
 

 
 

En el cuadro de insertar tabla una de las secciones más importantes y que aparece del lado 
derecho de la herramienta es justo las opciones en donde podemos: 
 
 

 
 
1 – Modo de Inserción. Aquí  la herramienta permite seleccionar entre las dos formas en 
que se puede insertar una tabla, ya sea por un punto de inserción o bien por medio del 
tamaño de una ventana. 

 

• Punto de Inserción. - Coloca la tabla con 
las medidas resultantes de acuerdo con el 
Ancho de las columnas y largo de las filas, 
después de haber definido el número de filas 
y columnas que componen la tabla. 
 
 

 2 

 3 

 1 



133 
 

• Especificar Ventana. - Coloca la tabla 
del tamaño de la ventana dibujada dentro del 
espacio de trabajo. Esta opción puede tener 
fijo ya sea el número de filas o columnas y a 
partir de ese dato, calculara en automático 
cualquiera de las opciones de columna o fila 
según sea el caso. 
 
 
 

 
2 – Configuración de Fila y Columna. La herramienta permite el número de filas y 
columnas que formaran la tabla, así como el alto y el ancho de las celdas que la formen. 
 
3 – Estilo de Celdas. Esta opción permite cambiar el orden de los tipos de celda que forman 
la tabla, esto es si queremos poner, los datos, luego el título, y finalmente los encabezados, 
etc. 
 
Cuando la tabla ya está colocada dentro del espacio de trabajo es muy fácil poder editarla, 
lo único que se tiene que hacer es dar click dentro de alguna de las celdas que forman la 
tabla. Inmediatamente se visualizarán las Filas relacionadas con números y las columnas 
con letras, tal cual aparecen en un editor de hoja de cálculo de uso común. 
 

 
 

 
Al realizar esta acción aparece en el Ribbon, la pestaña Celda de Tabla (Table Cell) que 
permite editar de una forma dinámica y sencilla el formato y estilos de la tabla seleccionada. 
 
Nota.- Si se quiere salir de la herramienta de edición de tablas, con presionar la tecla ESC 
para salir de la herramienta. Para ingresar nuevamente, daremos click en el centro de 
cualquiera de las celdas que forman la Tabla.  
 

 
 
 
Nota.-  Para el caso de editar el formato de texto para el contenido de las celdas de tabla, 
nos daremos cuenta que la herramienta que se activa será la correspondiente a los Textos 
Dinámicos, lo que hace 100% amigable la edición. 
 
Opciones de Edición de Tablas Dinámicas 
 
Lo primero que encontramos en la pestaña Celda de Tabla (Table Cell) (de Izquierda a 
derecha) son los paneles de Fila (Rows) y Columnas (Columns). En donde la herramienta 
permite insertar y eliminar filas y columnas en la tabla seleccionada. 
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Para el caso de las Filas se pueden insertar Filas por encima y por debajo de la celda que 
se encuentra seleccionada. Para las Columnas se pueden agregar columnas a la derecha 
y a la izquierda de la celda seleccionada. 
 

 
 
Después encontraremos el panel que permite Combinar (Merge Cell) las celdas 
seleccionadas de una Tabla, dicha opción permite realizarse por medio de 3 formas:  
 

 
 
Merge All (Combinar Todo).- Permite combinar las celdas que se encuentren selecionadas. 
 
Merge By Row (Combinar por Fila).- Permite combinar todas las celdas de la Fila 
seleccionada. 
 
Merge By Column (Combinar por Columna).- Permite combinar todas las celdas que forman 
la columna selecionada. 
 
La opción de Descombinar (Unmarge Cell) permite separar nuevamente las celdas que se 
encuentren combinadas. 

 
 
El siguiente panel que encontramos es el de Estilo de Celdas (Cell Styles), este panel 
permite configurar las propiedades de la celda como son la alineación, el color de fondo, 
asi como los bordes a mostrar para dichas celdas seleccionadas. 
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La siguiente figura muestra la herramienta que permite la alineación del contenido de las 
celdas. Como podemos ver dichas alineaciónes son muy semejantes o iguales a las 
utilizadas en cualquier editor de hoja de calculo de uso comun. 
 

 
 
En este panel de Estilo de Celdas (Cell Styles), también es posible asignarle un color de 
fondo a las celdas, por medio de las librerías y paletas de colores que ya conocemos en 
AutoCAD. Además, permite también ingresar a las herramientas de configuración y 
visualización de los bordes de las celdas seleccionadas. 
 

 
Para la herramienta de configuración y visualización de 
los bordes tenemos la posibilidad de cambiar el estilo y 
grosor de las lineas que forman la tabla.  
 
 
 
 
 
 
 
 
 
En el panel de Formato de Celdas (Cell Format), es 
posible configurar en primer lugar el bloqueo de las 
celdas, ya sea en su contenido, en su formato o en 
ambos parámetros. 
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Además, permite configurar también los formatos de los datos contenidos dentro de las 
celdas, si se trata de monedas, porcentajes, números, fechas, texto, etc. 
 
 

 
 

Finalmente, encontramos el panel de Insertar (Insert), en donde podemos agregar 
simbología (Bloques) dentro de las celdas de tabla, además de la opción de trabajar con 
fórmulas tal cual se realizaría en un editor de hoja de cálculo de uso común. 
 
Las Tablas dinámicas, permiten un fácil manejo y configuración, haciendo de estas una 
herramienta muy potente de uso común. 
 

Bloques 
 
Creación e inserción de símbolos (Bloques) 

 
Bloque es un grupo de objetos que pueden y deben agruparse si es posible, y que permiten 
la fácil manipulación y almacenamiento para usarse nuevamente.  
 
Definir formalmente un bloque. Se trata de una colección de objetos que se agrupan y se 
mantienen unidos bajo un nombre de identificación. Estos objetos se pueden copiar, mover, 
borrar, y sobre todo lo demás es que no importa el número de objetos que lo forman, 
funcionan como una Unidad.  

 
Un ejemplo de ingeniería es un engranaje con el diseño de todos sus dientes de intrincado. 
En donde docenas, y si no cientos de líneas y arcos forman el equipo. Aquí sería obligatorio 
convertir todos los elementos en un bloque. Sin embargo, existe otra razón más convincente 
por la que se pueden usar los bloques.  
 
Esta razón es el concepto de la reutilización y el uso de las bibliotecas. Los bloques se 
pueden guardar y reutilizar en proyectos futuros, en donde puede ser necesario utilizar el 
mismo objeto. Así usted nunca tendrá que trabajar la misma cosa dos veces, en AutoCAD 
una Regla de oro.  
 
Una colección de estos objetos catalogados ordenadamente se convierte en un una 
biblioteca o librería; una parte indispensable de casi cualquier conjunto de herramientas de 
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diseño. Posibles candidatos de estas bibliotecas pueden ser puertas, ventanas, muebles, 
tornillos, piezas estándar, sujetadores, maquinaria, válvulas, tubos, equipos de Aire 
Acondicionado, señalización, etc. y realmente cualquier cosa que se puede utilizar en más 
de un diseño o dibujo. 

 

 
 

Ejemplo de un Bloque de Instalación Industrial 

 
Existen varios métodos para crear bloque. 
 

• Combinar objetos para crear una definición de bloque en el dibujo actual. 

• Crear un archivo de dibujo e insertarlo después como un bloque en otros dibujos 

• Crea un archivo de dibujo con varias definiciones de bloque relacionados que 
funcionen como una biblioteca de bloques 

 
Un bloque puede estar compuesto por objetos dibujados sobre varias capas con distintas 
propiedades de colores, tipo y espesores de línea. Aunque un bloque siempre se inserta 
sobre la capa actual, la referencia de bloque conserva la información sobre las propiedades 
originales de la capa, color y tipo de línea de los objetos contenidos en el bloque. 

 
Como activar el comando: 
 

Block 
 

Ribbon: Pestaña Home ➤ Panel Block ➤Create Block 

Ribbon: Pestaña Insert ➤ Panel Block Definition ➤ Create 

Block 
Línea de Comando: Block (B) 
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o Teniendo dibujado lo que queremos convertir en bloque 
 
 

 
 

o Ejecutar el comando. 
 

o Aparecerá el cuadro de diálogo Definición de bloque (Block Definition) 
 

 
 
 

o Cuando aparece el cuadro de Definición de bloque (Block Definition) lo primero que 
tenemos que hacer es asignar un nombre para el nuevo bloque. 
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o Después tenemos que seleccionar el punto de inserción del bloque (Punto Base). 
La selección puede ser mediante coordenadas o gráficamente pulsando el botón 
“Pick Point” 
 
 

 
 

o Después tenemos que seleccionar los objetos que forman el bloque, esto es por 
medio del botón “Select objects”. Aquí existen tres opciones para crear un bloque. 
La más común de selección es “Convert to block” 

 

 
 

 
 

Retener (Retain).- Permite crear un bloque a partir de los objetos seleccionados, 
pero sin que los objetos de origen se agrupen en un bloque. 
 
Convertir en Bloque (convert to block).- Permite crear un bloque a partir de los 
objetos seleccionados, agrupando los objetos de origen en un bloque. 

 
Suprimir (Delete).- Permite crear un bloque a partir de los objetos seleccionados, 
eliminando los objetos de origen. 
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o Una vez que se ha configurado el Bloque, aceptamos el cuadro dando OK. 

 

 
 
 

o Después de aceptar el cuadro de datos, seleccionaremos nuevamente el objeto que 
fue convertido en bloque y a diferencia del principio, el objeto será un solo elemento 
y solamente mostrará un Grip en el lugar que se haya seleccionado como Punto 
Base. Nuestro Bloque está listo para ser usado. 

 

 
 

 
El nuevo bloque estará activo EXCLUSIVAMENTE en el proyecto en el que fue creado. Si 
se desea guardar en alguna carpeta, para que forme parte de nuestras librerías tendremos 
que ir al Panel  “Block Definition” y allí seleccionar la opción “Write Block” (Escribir Bloque).  
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Write Block 
 

Ribbon: Pestaña Insert ➤ Panel Block Definition ➤ Write Block 

Línea de Comando: WBlock 
 
 
 
 
 
 
Automáticamente se abrirá el cuadro que permitirá ubicar la carpeta y el bloque que se 
desea guardar. Es importante señalar que si el bloque ya se ha creado (Que es lo más 
correcto hacer primero el bloque y luego guardarlo), en este cuadro de “Write Block” 
aparecerán inactivas las opciones de seleccionar los objetos y la de definir el punto base. 
 

Dentro de la herramienta de “Write 
Block”, lo único que tenemos que 
hacer es seleccionar lo que se desea 
guardar en las carpetas. 
 
La herramienta ofrece tres tipos de 
opciones para los objetos a Guardar: 
 
Block.- Permite Guardar un bloque 
creado con anterioridad. 
 
Entire drawing.- Permite Guardar 
Todo el proyecto completo en una 
entidad de bloque. Esto lo hará más 
ligero cuando se trata de un gran 
proyecto. (Recordemos que un bloque 
es una sola entidad) 
 
Objects.- Permite definir directamente 
el bloque como lo hemos descrito 
anteriormente.  
 

 
En la sección de “Destination” de la herramienta, seleccionáremos el directorio en donde 
queremos guardar nuestro bloque, damos clic en OK y el bloque ha sido guardado en 
nuestra librería.  
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Insertar o usar un Bloque (Insert Block) 
 
Cuando hablamos de Insertar el bloque, se referimos a la posibilidad de usarlo en este o 
futuros proyectos.  
 
Los bloques pueden ser también los que se encuentran en nuestra librería o bien algún 
bloque descargado de Internet. 
Como activar el comando: 
 

    
Insert 
 

Ribbon: Pestaña Home ➤ Panel Block ➤Insert 

Ribbon: Pestaña Insert ➤ Panel Block ➤ Insert 

Línea de Comando: Insert (I) 
 

o Ejecutar el comando. 
 

o Automáticamente se abrirá el cuadro de Insertar. 
 

 
 

o Seleccionar de la casilla “Nombre (Name)”  el bloque a Insertar o bien dar click en 
el botón “Browse” para localizar la carpeta en donde se encuentra guardado nuestro 
bloque si se trata de una librería. 

 
 

o Después seleccionáremos el punto de Inserción, donde tenemos la posibilidad de 
especificar un punto de inserción en la pantalla o bien asignarle las coordenadas 
X,Y y Z para su ubicación dentro del proyecto. 
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Para el caso de la Escala, 
podemos asignarle un Factor 
diferente a 1, que es el valor por 
Defecto del Objeto (El tamaño 
con que fue creado). Hay que 
recordar que si los valores son 
Mayores que 1 el objeto será más 
grande y si es Menor que 1 será 
más pequeño.  
 
 

 
La escala también permite seleccionar la casilla que permite definir este Factor 
directamente en la pantalla, por si se tiene alguna referencia en cuanto al tamaño. 
 

o Una vez definido el modo de insertar el bloque damos OK para aceptar el cuadro. 
El bloque aparecerá en el puntero o bien en la coordenada de referencia a la que 
fue asignada.  

 

 
 
Edición de bloques 
 
Se pueden modificar los bloques que se hayan insertado en el dibujo. Es posible volver a 
definir los bloques en el dibujo actual. La redefinición de un bloque afecta a las inserciones 
previas y futuras del bloque dentro del proyecto. 
 
Es importante señalar, que los bloques que se hayan descargado de internet, o provengan 
de una librería cualquiera, también pueden ser editados sin restricción alguna. 
 
A partir de la versión 2006 de AutoCAD editar un bloque es muy sencillo. Antes de esta 
versión la edición de bloques consistía en Explotar (Explode) el bloque, realizar los cambios 
y volver a realizar el proceso de crear un bloque (Create Block). 
 
Pero en la versión 2006, se incorpora una herramienta que permite editar al 100% los 
bloques contenidos en cualquier proyecto. Esta herramienta se conoce como Editor de 
Bloques (Block Editor).  
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Como activar el comando: 
 

   Block Editor 
 

Ribbon: Pestaña Home ➤ Panel Block ➤Edit 

Ribbon: Pestaña Insert ➤ Panel Block Definition➤ Block Editor 

Línea de Comando: Bedit (Be) 
 

o Ejecutar el comando. 
 

o Automáticamente se abrirá el cuadro de Edición de Bloques (Edit Block Definition) 
 

o Seleccionar el bloque a editar y damos OK 
 

 
 

o Se activará inmediatamente en el Ribbon, la pestaña Editor de Bloque (Block Editor). 
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Cuando la pestaña “Block Editor” se encuentra activa, tenemos la posibilidad de 
modificar el bloque sin restricción alguna. Dentro del editor podemos cambiar 
además de la geometría, las propiedades que tiene dicho bloque. Además, todo lo 
que hemos visto hasta ahora es aplicable dentro del editor de bloques. 
 

o Una vez realizados los cambios, tenemos dos formas de guardar dichas 
modificaciones. La primera forma y la más sencilla, es dando click sobre el tache 
(Close Block Editor) que ese encuentra al final de cualquier barra de herramientas 
mientras se encuentre abierto el editor.  
La única desventaja es que esta opción afectaría directamente al bloque que se ha 
editado.  

 
 
La otra forma de guardar los cambios es ir directamente a la 
pestaña “Block Editor” y en el Panel de “Open/ Save” 
encontraremos las opciones de Guardar Bloque Como (Save 
Block As) que permitirá renombrar el bloque. Así tendremos 
dos bloques totalmente diferentes. 

 
 
  

o Finalmente le damos click al botón Cerrar el Editor (Close Block Editor) y nuestro 
bloque estar listo para usarse. Si se decidió sobre-escribir el bloque existente 
automáticamente se mostrar los cambios en los bloques de esa definición. 
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Capítulo 7 – Acotación y dimensionamiento 
 
Pueden añadirse medidas al dibujo con varios comandos de acotación. Utilice los estilos de 
cota para dar formato a las cotas de forma rápida y mantener las normas sobre cotas del 
proyecto. 
 
Se pueden crear varios tipos de cotas, así como controlar su aspecto configurando los 
estilos de cotas o editando las cotas una a una. 
 
 

Información general de las acotaciones. 
 
La acotación es el proceso por medio del cual se añaden anotaciones de medida a un 
dibujo. 
 
Se pueden crear cotas para una gran variedad de tipos de objeto en muchas orientaciones. 
Los tipos básicos de cotas son: 
 

Lineal. Permite medir distancias mediante cotas horizontales, verticales, alineadas, 
giradas, de línea base (paralelas) y continúas (encadenadas). 
 
Radial. Permite medir los radios y diámetros de los arcos y círculos. 
 
Angular. Permite medir el ángulo formado por dos líneas o tres puntos. 

 

 
 

Además de una nueva herramienta llamada DIMENSION , esta herramienta crea 
varios tipos de cota en una única sesión de comandos. 
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NOTA.- Para simplificar la organización de los dibujos y la atribución de escala de las cotas, 
se recomienda crear cotas en las Presentaciones (Layout) en lugar del Espacio Modelo. 

 

Partes de una cota 
 
Las cotas tienen diversos elementos: texto de cota, líneas de cota, extremos de cota y líneas 
de referencia. 
 

 
 
 

Línea de cota. Indica la dirección y extensión de una cota. En los ángulos, la línea 
de cota es un arco. 

 
Línea de referencia. Se extiende desde la característica que se está acotando 
hasta la línea de cota. 

 
Texto de cota. Refleja el valor de cota y puede incluir prefijos, sufijos y tolerancias. 
Si se desea, es posible incluir texto propio o suprimir el texto completo. 

 
Extremo de cota. Indica un extremo de la línea de cota. Hay disponibles varios tipos 
de flechas, incluidos oblicuos gruesos y puntos. 

 
Directriz o Lider. Forma una línea continua desde una anotación hasta la 
característica a la que se hace referencia. En función del estilo de cota, es posible 
que se creen directrices automáticamente si el texto de cota no se ajusta entre las 
líneas de referencia. También se pueden crear directrices para conectar texto o un 
bloque con una característica. 
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Nota.- Por defecto, las cotas son asociativas. Las medidas que muestran las cotas 
asociativas se actualizan automáticamente al modificar los objetos o puntos a los que están 
asociadas. 
 

Creación de Cotas. 
 
Para colocar las cotas a un proyecto tenemos un panel exclusivo para el uso de esta 
herramienta. 
 

 

Ribbon: Pestaña Annotate ➤ Panel 

Dimensions 
 
 

 
 
Se pueden acotar líneas, arcos, círculos y muchos otros tipos de objetos. Hay dos formas 
principales de crear cotas: 
 

1. Seleccionar un objeto para su acotación (1) y especificar la ubicación de la línea de 
cota (2), según se muestra en la Figura. 

 

 
 
Al seleccionar cualquier comando de acotación, en la línea de comando aparecerá la opción 
de especificar el origen de la primera línea de extensión o <Seleccionar Objetos>: 
 

 
 
 
Para el caso de seleccionar el objeto para su acotación presionar Enter y el programa pedirá 
seleccionar el objeto a acotar. 
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2. Utilizar referencias a objetos para precisar el origen de las líneas de referencia y, a 
continuación, especificar la ubicación de la línea de cota. Los puntos de origen de 
las líneas de referencia pueden estar en objetos diferentes. 

 

 
 
Al seleccionar cualquier comando de acotación, en la línea de comando aparecerá la opción 
de especificar el origen de la primera línea de extensión o <Seleccionar Objetos>: 
 

 
 
Para el caso de seleccionar las referencias para su acotación dar clic en la primera 
referencia donde se colocará la cota y el programa pedirá automáticamente seleccionar la 
segunda referencia a acotar. 

 

 
 

Al seleccionar la segunda referencia, el programa pedirá automáticamente dar click para 
fijar y ubicar la posición final de la cota. 
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Nota.- Estos 2 métodos según sea el caso, se pueden  realizar para todos los tipos de cota 
que permite AutoCAD. 

 

Tipos de Cota 
 
Cotas Horizontales y Verticales (Linear) 
 

El programa aplica automáticamente una cota 
horizontal o vertical de acuerdo con los orígenes de la 
línea de referencia especificados o la ubicación donde 
se seleccione un objeto. 
 
Sin embargo, puede modificar esta cota mientras la 
crea especificando que sea horizontal o vertical.  
 

 
 
 
 
 
 
 
 
 
 
 

 
 
Nota.- Por medio de la Cota Linear solo se pueden dibujar cotas Horizontales y Verticales. 
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Cotas Alineadas (Aligned) 
Son cotas paralelas a las ubicaciones u objetos que 
especifique. 
 
Las cotas alineadas se caracterizan porque la línea de 
cota es paralela a los orígenes de las líneas de 
referencia. Estas cotas pueden ser también 
Horizontales y Verticales.  
 
La imagen muestra ejemplos de cotas alineadas.  

 
Cotas Angulares 
 
Las cotas angulares miden 
el ángulo formado por dos 
líneas. 
 
Para medir el ángulo entre 
dos radios de un círculo, 
seleccione el círculo y 
precise los puntos finales del 
ángulo. Con otros objetos, 
selecciónelos y precise la 
ubicación de la cota. 

También se puede acotar un ángulo indicando el vértice y los 
puntos finales.  
 
Mientras crea la cota, se puede modificar el contenido del 
texto y la alineación antes de precisar la ubicación de la línea 
de cota. 

              
 
 
Cotas de longitud de arco 
 
Las cotas de longitud de arco miden la distancia del segmento de un arco de polilínea o un 
arco. 
 
El símbolo de arco, también conocido por sombrero, se muestra por encima o delante del 
texto de cota. Puede especificar el estilo de ubicación utilizando el Administrador de estilos 
de cota. El estilo de ubicación se puede modificar en la ficha Símbolos y flechas de los 
cuadros de diálogo Crear estilo de cota o Modificar estilo de cota. 
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Las líneas de referencia de una cota de longitud de arco pueden ser ortogonales o radiales. 
 

 
 

Nota.- Las líneas de referencia ortogonales sólo se muestran cuando el ángulo incluido del 
arco es inferior a 90 grados. 
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Cotas Radiales 
 
Una cota radial indica el radio y diámetro de un arco o un círculo con líneas de centro o 

marcas de centro opcionales. 

 

Hay dos tipos de cotas radiales: 
 

• RADIO. Mide el radio de un arco o un círculo y muestra el texto de cota con la letra 
R delante. 

 

• DIÁMETRO. Mide el diámetro de un arco o círculo y muestra el texto de cota con el 
símbolo de diámetro delante. 
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Cotas de Radio con Recodo 
 
Se pueden crear cotas de radio con recodo, también 
conocidas como “cotas de radio con escorzo”, cuando 
el centro de un arco o un círculo se encuentra fuera de 
la presentación y no se puede visualizar en su 
verdadera posición. El punto de origen de la cota se 
puede precisar en una ubicación más conveniente 
conocida como reemplazo de ubicación de centro. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Se puede controlar el ángulo por defecto del recodo en el cuadro de diálogo Modificar estilo 
de cota, dentro de la ficha Símbolos y flechas, en Recodo de 
cota de radio. 
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Capítulo 8 – Presentaciones e Impresión 
 

Impresión 
 
El objetivo final al generar un dibujo en AutoCAD suele ser la impresión de nuestros planos. 
Para ello existen una gran variedad de opciones, las cuales requieren cierta experiencia 
con la interfaz del programa y estar familiarizado con su impresora  y los ajustes que 
la misma pueda tener. 
 
Por estas razones en este capítulo describiremos las opciones de configuración básicas 
para lograr una impresión adecuada y con ello proporcionar las herramientas suficientes 
que permitan afinar 
 sus conocimientos y obtenga mejores resultados. 
 

 
 

Objetivos 
 
Al terminar este capítulo, estará en capacidad de: 
 

• Entender la configuración de impresión. 

• Usar el espacio de papel y controlar la visualización de sus modelos. 

• Llevar a cabo el proceso de impresión. 
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Espacio modelo y el espacio papel 
 
Una vez que se ha completado el proyecto, la parte más importante sin lugar a duda es la 
configuración de la impresión. 
 
Anteriormente tanto el proyecto, como la impresión, se desarrollaban sin excepción dentro 
del Espacio de Modelo (Model Space). Actualmente la metodología dentro de AutoCAD ha 
cambiado considerablemente, por lo que ahora la impresión se recomienda se realice 
dentro del Espacio de Papel (Paper Space (Layout)). 
 
En la parte inferior de la ventana de dibujo hay una Pestaña Modelo y una o más Pestañas 
de Presentación (Layout). Al seleccionar cualquiera de las pestañas de Layout 
automáticamente se cambia la vista de la pantalla de trabajo (Modelspace) por una 
representación de hoja de papel para imprimir (Paper Space). 
 

 
 
Esta representación de una hoja de papel tiene una configuración Tamaño Carta 
predefinida por AutoCAD, el área que aparece punteada, representa el margen de 
impresión correspondiente a cada dispositivo (impresora, plotter, etc) que se pueda 
configura para impresión.  
 
Es importante señalar, que dentro de este espacio de papel se pueden utilizar todas y cada 
una de las herramientas de dibujo, modificar, textos, tablas, bloques y demás herramientas 
que ya se han trabajado con anterioridad. Además, TODO lo que quede fuera del área 
imprimible será excluido de la impresión. 
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La hoja de impresión se puede modificar al 100%, lo único que tenemos que hacer es 
colocar el puntero sobre la pestaña de Layout a modificar y dar click con el botón derecho 
del Mouse. 
 

 
 
Al dar click con el botón derecho del mouse, aparecerá un menú donde seleccionaremos la 
opción Administrador de Configuración de Hoja (Page Setup Manager) 
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Al seleccionar esta opción automáticamente aparecerá el cuadro de herramientas de 
Configuración de Hojas (Page Setup Manager). Dentro del Administrador seleccionar la 
Presentación (Layout) que se desea modificar. 
 

 
 
Al seleccionar la opción Modificar (Modify) se mostrará automáticamente el configurador de 
Hojas. 
 

 
Este configurador de 
hojas no es otro que el 
mismo utilizado para 
definir las Propiedades 
de Impresión. Aquí 
tendremos la posibilidad 
de seleccionar el 
dispositivo de impresión, 
el tamaño del papel, los 
estilos de ploteo y 
algunas otras 
herramientas que 
permiten hacer más 
simple este proceso. 
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Configuración del Espacio de Impresión. 
 
Lo primero que debemos hacer dentro del administrador es seleccionar el dispositivo 
(impresora, Ploter) al cual se desea mandar el proyecto para impresión. 
 

 
 
Después de haber seleccionado el dispositivo de impresión, lo siguiente que tenemos que 
hacer es seleccionar el tamaño de papel adecuado según la escala a la cual se desea 
imprimir. Los tamaños de papel se muestran de acuerdo con el formato de plotter o 
impresora seleccionado. 

 
 
Para el área de ploteo escogeremos la opción “Layout” pues es la hoja de presentación la 
que se desea imprimir y configurar para este fin. 
 
Nota.-  Anteriormente en esta sección, se escogía la opción de Window y se seleccionaba 
el área a imprimir directamente del Espacio de Modelo. Ahora esa opción ya no es muy 
usada como método de impresión, ya que el espacio de papel ofrece una forma muy 
dinámica de impresión. 
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La opción de “Plot Offset” (Separación de Ploteo) tiene que ver con la separación que se le 
puede dar al Puerto de Impresión (Viewport) con respecto del área imprimible. Dicha 
separación toma la esquina inferior izquierda del área imprimible como el origen y de allí es 
que toma los valores X y Y para la separación.  
 

 
 

 
 

Para el caso de la Escala de Impresión es muy importante que en este cuadro siempre se 
deje la escala con valor de 1:1 ya sea en milímetros (mm) o pulgadas (inches)(no 
importando la escala en que nosotros queremos imprimir). 
 
Nota.-  Cuando la impresión será desde el Espacio de Modelo este será el lugar donde se 
debe configurar la Escala de Ploteo, pero en nuestro caso como las impresiones serán 
desde el Layout, tenemos la posibilidad de configurar cada Puerto de Impresión (View Port) 
con la escala deseada. 
 
 

Origen 
0,0 
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Del lado derecho de la herramienta de configuración, se encuentra la opción de “Plot style” 
que nos permitirá elegir el Estilo de Ploteo. 
 
La opción “Plot style” nos permitirá elegir el Estilo de ploteo,  función que tiene que ver 
específicamente con los grosores y colores de línea que se usarán según la escala del 
layout. El usuario puede configurar varios archivos de estilos de ploteo, según las escalas 
de impresión que use con más frecuencia. 
 

Para los Estilos de Ploteo tenemos. 
 
Acad.ctb.- Imprime con los valores asignados al 
proyecto (Color, Calidad y Tipo de Línea), si nuestro 
dispositivo es a color, esta es la opción para lograr ese 
resultado. 
 
Grayscale.ctb.- Imprime en diferentes tonos de grises. 
Esta opción sustituye los colores por las variaciones de 
gris para diferenciar los objetos y respeta las calidades y 
tipos de línea. 
 
Monochrome.ctb.- Imprime no importando los colores 
asignados en Blanco Y Negro, respetando las calidades 
y tipos de línea. 

 
Las opciones de Screening, imprimen todo en un mismo tono de gris que va desde el 25 %, 
50% 75% y 100% de tono de gris. 
 
Finalmente hallar las opciones de ploteo que permite configurar algunas opciones 
adicionales de salida de nuestro proyecto. 
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“Plot object lineweights” permite eliminar solo para 
impresión las calidades asignadas a las líneas. Si la 
casilla esta seleccionada las calidades se mostraran en 
la impresión. 
 
“Plot Transparency” permite imprimir o no las 
transparencias que se aplican en los sombreados 
(Hatch), Recordar que esta opción es exclusiva solo a 
partir de versión 2012. 
 
“Plot with plot styles” permite imprimir con las 
configuraciones hechas al Espacio de papel. 
 
“Hide paperspace objects” permitirá ocultar los 
objetos dibujados sobre el espacio de papel. 

 
Una vez realizada la configuración, dar OK para aceptar el cuadro de configuración, y poder 
regresar a nuestra hoja de presentación ya configurada. 
 
Es importante señalar que cuando se regresa al principio del administrador después de 
haber configurado la hoja de impresión, el administrador muestra la información configurada 
del Layout seleccionado. 
 

 
 

Cerrar el administrador y nuestra hoja está configurada. El siguiente paso que tenemos que 
hacer es configurar las vistas de impresión de nuestro modelo. Para ello tenemos que 
seleccionar y borrar el puerto de impresión (Viewport) que coloca por default AutoCAD. 
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Ventanas de impresión 
 
Para comenzar la configuración de las ventanas de impresión, es necesario ir a: 
 

Ribbon: Pestaña Layout ➤ Panel Layout Viewports 

 
 

 
 
Con estas herramientas será posible configurar las vistas de impresión de nuestro proyecto. 
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Puertos de Impresión (Viewports). 
 
En panel Viewports, escoger opción “Named” (Nombrada), para crear hasta 4 ventanas 
iguales en el Layout, utilizando varias formas de distribución. 
 

 
 
El cuadro de dialogo Viewports en la pestaña New Viewports  mostrará un listado de 
configuraciones posibles para la distribución de las ventanas 

 
 
Al dar OK, el comando preguntará si se desea definir el área que utilizaran los puertos 
mediante una ventana o rectángulo, o bien si se desea utilizar toda el área de impresión. 
 
Si se desea trabajar por medio de ventanas tendremos que definir el área que ocuparan los 
viewports (Fig. 1), de lo contrario deberá escoger la opción “Fit” (Ajustar) que permite ocupar 
toda el área de impresión (Fig. 2). 
 
La Fig. 1 muestra la opción para definir el área que ocuparan los puertos por medio de una 
ventana. La fig. 2 por el contrario nos muestra la forma en cómo se muestran las ventanas 
al seleccionar la opción “Fit”. 
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Una vez que se han colocado las ventanas en el espacio de impresión, será necesario editar 
cada uno de ellos para definirles su escala y objetos a visualizar dentro de cada puerto. 
Para ello, lo primero que tenemos que hacer es dar doble click sobre el puerto al cual se le 
quiere modificar la vista. 
 

Fig. 2 
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Nota. - Cuando estemos dentro de los puertos es importante tener mucho cuidado con lo 
que se realice cuando se esté dentro, pues en este punto es como si se estuviera 
directamente dentro del espacio de modelo pero desde el espacio de papel. 
 
Lo que borremos y dibujemos afectara directamente a nuestro Proyecto. Cuando se está 
trabajando solo en espació de papel el UCS (Sistema de Coordenadas del Usuario) se 
mostrará de forma triangular, indicando que el modelo está bloqueado. 
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Cuando se está desde el espacio de papel, pero 
dentro del modelo el UCS se muestra como se le 
conoce tradicionalmente. 
 
Además, una característica importante es que el 
puerto se muestra con el contorno resaltado 
(Negrita), para lo único que se recomienda ingresar 
al modelo desde el papel es SOLO para ajustar la 
vista para impresión. 
 
 
Los puertos como lo hemos comentado 
repetitivamente se comportan de forma 
independiente, por lo que este proceso será 
necesario realizarlo en cada uno de los puertos de 
impresión. 
 
 
 
 
 

 
 
 
Otra forma de poder definir los puertos de impresión es utilizando las demás herramientas 
contenidas dentro del panel viewports. 
 
“Rectangular” permite colocar el puerto de una forma muy semejante al comando 
“Named”. Esta opción permite definir un puerto no importando el tamaño (Fig. 3) o bien por 
medio de la opción Fit (Fig.4), para utilizar toda el área imprimible. 
 

 
Esta opción de “Rectangular” se pude decir que es la de más uso 
cuando se trata de colocar los viewports. 
 
 
 
 

 
 
 

Opción de definir la ventana por medio de una ventana con el comando 
“rectangular” 
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“Polygonal” permite colocar un puerto por medio de una polilínea. No importa la forma que 
esta tenga al final del dibujo de la polilínea, el resultado final será un puerto con una forma 
irregular. 
 
Esta opción de permite en cierta forma resaltar detalles. Además, deja en claro que una 
ventana gráfica es como romper la hoja de papel para poder mirar hacia el espacio de 
modelo (Fig. 5). 
 
El proceso es dibujar una polilínea y al terminar presionar Enter, con esto se convertirá en 
el puerto de impresión. 
 
 

 
 
 
“Object” permite a partir de cualquier geometría cerrada que esta dibujada sobe el espacio 

de papel la posibilidad de convertirlo en un puerto de impresión. 
 
Esta opción permite al 100% el manejo de los detalles en las vistas de 
modelos, además de que permite resaltar dicha vista. 
 
La única restricción para que los objetos sean convertidos en puertos de 
impresión es que estén totalmente cerrados (polilíneas) (Fig.6). 

Opción de definir el puerto por medio de Fit con el comando “rectangular” 

 Opción de definir el puerto por medio del comando “Polygonal” 
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La Fig. 6 muestra claramente como cualquier geometría puede funcionar como un puerto 
de impresión. Tenemos que recordar que al ser un puerto de impresión las opciones de 
configuración (escala, layer, color, línea de contorno, etc.) son de forma independiente por 
cada puerto. 
 
Para generar los puertos a partir de objetos, tenemos que dibujar sobre la hoja de papel los 
objetos que queremos convertir en ventana, después seleccionar el comando y pedirá ir 
tocando uno por uno los objetos para convertirlo en automático en puertos de impresión. 
 

 
 
 
 
Una vez que hemos colocado los puertos de impresión de la forma que se crea conveniente 
de acuerdo con las necesidades de nuestro proyecto, lo siguiente que tenemos que hacer 
es lo más importante del proceso de impresión y es definir las Escalas de impresión de cada 
uno de los puertos o bien de forma general. 
 
Como lo hemos comentado cada puerto tiene sus propiedades particulares a partir de las 
cuales realizaremos dicha configuración, tanto de escalas como de visibilidad de los layers 
en cada puerto. 
 
Cuando se está dentro del Espacio de Papel, los Layers muestran una herramienta 
adicional a las mostradas dentro del espacio de modelo. 
 
Esta herramienta permitirá congelar el Layer seleccionado solo en el puerto en el que sea 
apagado. 

Opción de definir el puerto por medio del comando “From Object” 
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Recordemos que un Layer cuando se encuentra congelado, no es considerado para 
opciones de impresión, es decir este Layer no se imprime. 
 
 
 
 
 
 

Escala de Impresión. 
 
Para ajustar con precisión y coherencia la escala de cada vista mostrada en el proyecto, 
defina la escala de cada puerto de impresión (viewport) con respecto al espacio papel. 
 
Nota.- El ajuste del marco del puerto de impresión (viewport) no cambia la escala 
configurada de la vista de dicho puerto. 
 
En una Hoja de Impresión (Layout), el factor de escala es la relación entre el tamaño real 
del modelo exhibido en los puertos de impresión (viewprot) y el tamaño de la hoja de 
impresión (Layout). 
 
Al especificar la escala con la que desea imprimir el dibujo, es importante tomar en cuenta 
que las unidades reales con las que trabaja AutoCAD, esto por la siguiente relación de 
medidas para definir la escala correcta. 
 
AutoCAD permite dos formas de definir la escala, cada una de ellas tiene que ver en la 
forma y unidades en la que se dibujó el proyecto. Si el proyecto tiene una forma de dibujo 
1:100 ya desde el modelo, el tipo de escala utilizar será una escala personalizada. Si el 
proyecto se dibujó con valores reales 1:1 entonces utilizaremos una escala estandarizada. 
 

¿Cómo es lo correcto para lograr una escala de impresión? 
 
Dentro de AutoCAD, el valor real de 1m = 1000 mm. 
 
Como usuarios, cuando tenemos valores de 2.5m por ejemplo nunca escribimos 2500 
unidades a un segmento de líneas, ya que es más práctico dibujarlo con el valor de 2.5. De 
forma real tomando la consideración anterior de que 1m = 1000 mm. El valor de 2.5 
asignado en realidad es 2.5 mm y no 2.5 m, pero esto no importa ya que, si da cuenta, lo 
único que debe hacer es quitar los ceros al valor real. 
 
Esta opción lleva a que el dibujo desde que se está haciendo tenga una escala 1:100 
(Escalímetro). 
 
Si dibuja tomando en cuenta que 1 es igual a 1m y no a 1mm, lo que se tiene que hacer 
para sacar la escala personalizada de impresión es lo siguiente. 
 
El escalímetro (Unidades de Papel) es una herramienta que permite medir cualquier plano 
de un proyecto con una escala Normalizada. Este utensilio usado por Ingenieros y 
Arquitectos desde las épocas de dibujo a mano permite definir la escala de impresión en 
AutoCAD. 
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Nota.- El siguiente proceso aplica en el 95 % de los casos, ya que los usuarios no importan 
la especialidad que tengan cuando usan valores en metros regularmente toman como 
consideración 1 = 1 m. 
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De forma Real en AutoCAD  1m = 1000 mm 
 
Las unidades de papel en el escalímetro son: 
 
1 : 125 
1 : 100 
1 : 75 
1 : 50 
1 : 25 
1 : 20 
 
Por lo tanto, el valor de la escala del puerto de impresión (viewport) es igual a: 
 
Para una escala 1 : 125 
 

𝑉𝑝 =  
1 𝑚 𝑅𝑒𝑎𝑙 𝑒𝑛 𝐴𝑢𝑡𝑜𝐶𝐴𝐷

1𝑚 𝑒𝑛 𝑃𝑎𝑝𝑒𝑙 (𝐸𝑠𝑐𝑎𝑙𝑖𝑚𝑒𝑡𝑟𝑜)
=  

1000

125
= 8 

 
Para una escala 1 : 100 
 

𝑉𝑝 =  
1 𝑚 𝑅𝑒𝑎𝑙 𝑒𝑛 𝐴𝑢𝑡𝑜𝐶𝐴𝐷

1𝑚 𝑒𝑛 𝑃𝑎𝑝𝑒𝑙 (𝐸𝑠𝑐𝑎𝑙𝑖𝑚𝑒𝑡𝑟𝑜)
=  

1000

100
= 10 

 
Para una escala 1 : 75 
 

𝑉𝑝 =  
1 𝑚 𝑅𝑒𝑎𝑙 𝑒𝑛 𝐴𝑢𝑡𝑜𝐶𝐴𝐷

1𝑚 𝑒𝑛 𝑃𝑎𝑝𝑒𝑙 (𝐸𝑠𝑐𝑎𝑙𝑖𝑚𝑒𝑡𝑟𝑜)
=  

1000

75
= 13.33333 

 
Para una escala 1 : 50 
 

𝑉𝑝 =  
1 𝑚 𝑅𝑒𝑎𝑙 𝑒𝑛 𝐴𝑢𝑡𝑜𝐶𝐴𝐷

1𝑚 𝑒𝑛 𝑃𝑎𝑝𝑒𝑙 (𝐸𝑠𝑐𝑎𝑙𝑖𝑚𝑒𝑡𝑟𝑜)
=  

1000

50
= 20 

 
Para una escala 1 : 25 
 

𝑉𝑝 =  
1 𝑚 𝑅𝑒𝑎𝑙 𝑒𝑛 𝐴𝑢𝑡𝑜𝐶𝐴𝐷

1𝑚 𝑒𝑛 𝑃𝑎𝑝𝑒𝑙 (𝐸𝑠𝑐𝑎𝑙𝑖𝑚𝑒𝑡𝑟𝑜)
=  

1000

25
= 40 

 
Para una escala 1 : 20 
 

𝑉𝑝 =  
1 𝑚 𝑅𝑒𝑎𝑙 𝑒𝑛 𝐴𝑢𝑡𝑜𝐶𝐴𝐷

1𝑚 𝑒𝑛 𝑃𝑎𝑝𝑒𝑙 (𝐸𝑠𝑐𝑎𝑙𝑖𝑚𝑒𝑡𝑟𝑜)
=  

1000

20
= 50 

 
El resultado en cada caso será el valor que se coloque en la casilla correspondiente al valor 
de Escala Personalizada (Custom Scale) 
 
Para poder configurar la escala es necesario seleccionar el puerto e ingresar al cuadro de 
propiedades en donde se configurarán estas opciones. 
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Una vez seleccionado el puerto, en el cuadro de propiedades buscar en la sección de Misc 
(Varios) la casilla que se llama “Custom Scale” en ella introduciremos los valores obtenidos, 
según el valor de escala a representar en dicho puerto. 
 
Es importante señalar que en un plano podemos tener diferentes escalas de la vista del 
proyecto, lo que en antaño no sucedía. 
 
Al introducir el valor en la casilla “Custom scale” automáticamente la vista del puerto se 
ajustará al nuevo valor asignado. 
 
Para evitar mover la escala configurada, podemos ingresar en la opción “Display locked” de 
este mismo cuadro. Esta opción si se activa (Yes) bloquear la vista y ya no cambiara su 
escala. 
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Para el caso en que el proyecto se haya hecho con valores reales de AutoCAD (1m = 1000 
mm) el proceso es seleccionar la casilla de “Standard scale” en donde podemos seleccionar 
cualquier valor de escala estandarizada ya que nuestro proyecto se encuentra a escala 1 : 
1 y no 1: 100. 
 

 
 
Normalmente los objetos se dibujan a tamaño real, es decir, el usuario puede decidir cómo 
interpreta el tamaño de una unidad (una pulgada, un milímetro, un metro) y dibujar a una 
escala 1:1.  
 
Por ejemplo. Si la unidad de medida es en milímetros, cada unidad del dibujo representa 
un milímetro. Cuando se traza el dibujo, o bien se le atribuye una escala precisa o se ajusta 
la imagen de papel. 
 

 
 
Nota.-  AutoCAD permite agregar más hojas de impresión al proyecto. Por default AutoCAD 
solo muestra dos, pero en realidad no existe restricción alguna en el número de layouts que 
permite AutoCAD, además una vez configurado un layout, se puede crear una copia de 
dicha hoja de impresión. 
 
Algo que es importante tomar en cuenta, es que en el Layout (Espacio de Impresión) 
tendremos que dibujar nuestros Pies de Plano, así como lograr las vistas de nuestro 
proyecto. Recordar que en este espacio de trabajo se encuentran disponibles todos los 
comandos y herramientas de dibujo de AutoCAD (Líneas, círculos, textos, tablas, bloques, 
etc.) con el fin de lograr la mejor presentación para nuestra hoja de impresión (Layout). 
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Creación de Plantillas. 
 
Para generar nuestro Pie de Plano y que se encuentre disponible cada que mandemos a 
imprimir, además de algunas opciones adicionales, encontrar la posibilidad de trabajar con 
Plantillas (Template). 
 
Recordar que cuando abrimos un archivo nuevo AutoCAD da la posibilidad de elegir entre 
varias plantillas precargadas con el programa, de las cuáles se utilizan dos de forma 
principal: acadiso.dwt (Métrico) y acad.dwt (Ingles). 
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Lo primero que haremos será seleccionar la plantilla correspondiente. Para nuestro caso 
será acadiso.dwt.  
 
Dentro de la plantilla, sin realizar ningún trazo, hay que configurar los Layouts. Recordar 
que se puede tener tantos layouts como sea necesario, esto da la posibilidad de configurar 
Hojas Tamaño Carta, Oficio, Tabloide, 30x45, 90x60, etc., dentro del mismo proyecto. 
 

 
 
Como se mencionó con anterioridad la hoja de impresión se puede modificar al 100%, lo 
único que tenemos que hacer es colocar el puntero sobre la pestaña de Layout a modificar 
y dar click con el botón derecho del Mouse. 
Al dar click con el botón derecho del mouse, aparecerá un menú donde seleccionaremos la 
opción de “New Layout” (Nueva Hoja) para agregar más hojas de impresión. Y para 
personalizar el nombre de cada pestaña de Layout seleccionar la opción “Rename” 
(Renombrar).  
 

 
 
Dentro del Layout dibujar el pie de plano, solo recordando que todo lo que este fuera del 
área punteada (Área de Impresión) no será efecto de impresión. 
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Para insertar un logotipo o imagen dentro del área de trabajo, ir a la Pestaña INSERT/ Panel 
REFERENCE/ ATTACH. 
 
En este panel de referencia es donde podemos insertar las imágenes para nuestros 
proyectos. 
 

 
 
Al presionar la opción de Attach (Agregar) aparecerá el cuadro “Select Reference File” 
donde seleccionaremos la imagen a Insertar. 
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Una vez seleccionada, presionar el botón Abrir “Open” y aparecer el cuadro “Attach Image” 
(Agregar Imagen) en donde configuraremos las opciones de insertar el archivo dentro de 
AutoCAD. 
 
Dentro de la herramienta “Attach Image” (Agregar Imagen), tener la posibilidad de 
seleccionar la escala y el punto donde se insertará la imagen. Si se marca la opción que 
dice “Specify on-screen” (Especificar en Pantalla) tendremos la posibilidad de insertar la 
imagen en el punto deseado por medio el puntero. 
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Una vez dentro del Espacio de Trabajo, no importando de cual se trate (Modelo o Papel) la 
imagen se comportará como cualquier objeto hecho dentro de AutoCAD. Esto permitirá 
copiarlo, moverlo, rotarlo o cambiarle la escala. 
 

 
 
Una vez configurado el Pie de Plano y hechas las hojas de impresión necesarias para 
completar nuestra plantilla, guardar el archivo como lo hacemos en la opción “Save” o “Save 
As..”, se le asigna un nombre, pero en lugar de guardarlo como archivo DWG, se guarda 
como DWT (Drawing Template). 
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Así la siguiente vez que se quiera trabajar un archivo nuevo la plantilla que podemos 
seleccionar es la o las plantillas que haya creado con anterioridad. 
 

 
 
 
Nota.- Es importante señalar que una plantilla aparte de los layouts, puede tener 
configuraciones adicionales como los Layers, Estilos de impresión, Estilos de texto, Estilos 
de tablas, Cotas y todo lo que necesitemos personalizar. 
 
Todo esto con la finalidad de que cuando se haga un nuevo proyecto no perder tiempo en 
este tipo de configuraciones. 
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